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MODULE 1 BASIC CONCEPTS IN MULTIMEDIA

Unit 1 Introduction to Multimedia

Unit 2 Hypermedia

Unit 3 Interactive Multimedia and Metamedia

Unit 4 Issues in Multimedia Systems Unit 5 Multimedia Tools: Hardware
Unit 6 Multimedia Tools: Software

INTRODUCTION

Multimedia simply means numerous or multiple medium. The term medium implies the
existence of a channel through which messages or information pass through. Multimedia
therefore refers to multiple channels through which we can send, receive, present, store or perceive
message or information.

When a teacher uses some sets of instructional materials such as the chalkboard, flash card,
textbook, flannel board, graph paper, audiocassettes and videocassettes etc. What he simply does
is to ensure effective teaching and learning of the subject matter.

DEFINITIONS

Multimedia has been defined variously by different scholars based on the technology
available as per time dictum. We will examine some of these definitions:

Multimedia is media that uses multiple forms of information content and information processing
(for instance audio, graphics, and video) to inform, entertain or educate the user (Access
Developer Network).

Multimedia is a combination of text, animated graphics, video, andsound delivered to an
audience which can be learners, listeners or viewers through electronic means (Batch elder).

In the words of Xie (1997), multimedia involed the computer-controlled integration of text,
graphics, still and moving images, animation, sounds and any other medium where every
type of information can be represented, stored, transmitted, and processed digitally.

Mayer (2001) defined Multimedia as presenting words (such as printed text or spoken text)
and pictures (such as illustrations, photos, animation, or video). Multimedia refers to the
combination of multiple media to effectively convey a message (Dorin & McCormack, 2000).

According to Marshall (2001), multimedia is concerned with the computer-controlled
integration of text, graphics, drawings, still and moving images (Video), animation, audio,
and any other media where every type of information can be represented, stored, transmitted and
processed digitally.

Ayo (2001) defined multimedia as the delivery of information in intuitive, multi-
sensory ways, through integration of distinct media such as texts, graphics, computer
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animation, motion video, and sound in a single presentation which is computer controlled.

Multimedia is the combination of a variety of communication channels for presenting text,
graphics, audio and video with links and tools that allow users to interact, create, navigate and
communicate (Elsom-Cook, 2001)

Multimedia refers to computer-based materials designed to be used on a computer that can display
and print text and high-quality graphics, play pre-recorded audio and video material, and create
new audio and video recordings (ICT4LT).

The concept of multimedia as observed from the various definitions above connotes
three facts, namely:

1. Presence of a message or information (content). The information could be a
learning material, news, business presentation, awareness creation on some health, political, social
Issues, or entertainment etc.;

2. Source and destination, speaker and listeners,teacher and students, government
and her citizens, business and its customers etc.;
3. Communication  channels (media) through  which  the information is passed.

These channels could be traditional means such as symbol, text, scrolls, spoken
words, graphics drawing, pictures, illustrations and images, or they could be in electronic forms
such as audiocassettes and radio presentations (audio), videocassettes and television
presentations (videos), slides, computer PowerPoint, YouTube, graphics animation.

Therefore, multimedia is a medium with multiple content forms (combination of different media)
having multiple content forms (combination of different content forms). In contemporary terms,
it refers to electronic (digital and computer) representations of information (text, voice, still images,
pictures and illustrations) and their interactive electronic presentations (text, audio, video,
animation, and interactive content forms).

Benefits of Multimedia
Multimedia is used based on the following reasons amongst others:

I. it enhances effective presentations;

ii. it is an effective and flexible communication tool;

iii. it is conducive to cooperative work environment;

iv. it facilitates high retention rate, hence high recall of knowledge content;

V. its supports large audience;

Vi. it encourages participatory learning through interactivity;
vii. it stimulates audience or learners interest in the subject; and
viii. it is easy to use, learn and understand.

Applications of Multimedia
A multimedia application is an application which uses a collection of multiple media
sources e.g. text, graphics, images, sound/audio, animation and/or video.
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Applications and delivery platforms of multimedia are virtually limitless. Multimedia
finds its application in various areas including, but not limited to, e-commerce (advertisements,
home shopping), education (hypermedia courseware), art and entertainment (video-on-
demand, interactive TV, games, digital video editing and production systems), engineering,
medicine, multimedia database systems, mathematics, business, scientific research, spatial
temporal applications (World Wide Web, Video conferencing, Groupware, Virtual
reality). Several examples are as follows:

1. Simulations: computer-based models of real-life situations or environments;

2. Business Presentations: used to sell products or ideas, can also serve to illustrate data
analysis or trends;

3. Computer Based Training: type of education in which students learn by using and
completing exercises with instructional software (also called Computer  Aided
Instruction CAl). CBTsoftware are generally flexible, time-wise, location-wise and
customized teaching programs with instant feedback. They are self-paced study and one-on-
one instruction;

4. Courseware: the name given to interactive CBT software which can be used to teach new
skills, teach quicker and at a lower cost, and train for situations;

5. Web Based Training (WBT)/Distance Learning: same basic principle as CBT but delivery
is via the web; Classroom and special education;

6. Electronic Books: a digital text that uses links to five the user access to information. E-
book is a small book-sized computer that can hold up to 4,000 pages (10 books) worth
of text and images. Electronic Reference (e-text) — a digital version of a reference book
which uses multimedia to provide additional information;

7. Multimedia Newspaper/  Electronic = Magazine: electronic version of a newspaper
distributed via CD-ROM or the Web. E.g. The Punch etc;

8. Virtual Reality (VR): the use of a computer to create an artificial environment that appears
and feels like a real environment and allows you to explore a space and manipulate the
environment;

9. Kiosks: acomputerized information or reference center that allows you to select
various options to browse through or find specific information (usually uses touch screen).
E.g. Target’s gift registry, Information centers at malls, hospitals, museums, airports etc.

Others include:

Commerce
Electronic commerce which is the process of buying, selling products and services and
information on computer networks dominate most commercial platforms today. Advertising

has gone through some laudable changes with the influence of multimedia. Sales
presentations are being conducting with catchy and stimulating PowerPoint presentations
which combine different forms of media content. Creative and advanced multimedia
presentations are being combined with a variety of online methods (matching services, web
services and advertising services of exchange) to reach business customers in business to
business (B2B) marketing.

Education

In Education, multimedia is used to produce computer-based training courses (popularly
called CBTs) and reference books and websites like encyclopedia, wikipedia and almanacs. A CBT
lets the user go through a series of presentations, text about a particular topic, and associated
illustrations in various information formats. Edutainment is an informal term used to describe
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combining education with entertainment, especially multimedia entertainment.

Arts and Entertainment

Multimedia is heavily used in the entertainment industry, especially to develop special effects
in movies and animations. Multimedia games are a popular pastime and are software programs
available either as CD- ROMs or online. Some video games also use multimedia features.
Multimedia applications that allow users to actively participate instead of just sitting by as
passive recipients of information are called Interactive Multimedia.

Engineering and Industry

Software engineers may use multimedia in Computer Simulations for anything from entertainment
to training such as military or industrial training. Multimedia for software interfaces are often done
as a collaboration between creative professionals and software engineers.

In the Industrial sector, multimedia is used as a way to help present information to shareholders,
superiors and  coworkers.  Multimedia is also helpful for providing employee training,
advertising and selling products all over the world via virtually unlimited web-based
technologies. Creative industries unse multimedia for a variety of purposes ranging from
fine arts, to entertainment, to commercial art, to journalism, to media and software services
provided for any of the industries listed below. An individual multimedia designer may
cover the spectrum throughout their career.

Mathematical and scientific research

In mathematical and scientific research, multimedia are mainly used for modelling and simulation.
For example, a scientist can look at a molecular model of a particular substance and
manipulate it to arrive at a new substance. Representative research can be found in journals
such as the Journal of Multimedia.

Medicine

In Medicine, doctors can get trained by looking at a virtual surgery or they can simulate how
the human body is affected by diseases spread by viruses and bacteria and then develop techniques
to prevent it.

Document Imaging, Digital Publishing and Library

Document Imaging is a technique that takes hard copy of an image/document and converts it into a
digital format

Spatial Temporal Applications

Video conferencing (web conferencing) is a virtual meeting in which participants in one location
can see and interacts with participants at other locations separated by geographical
distance but which is facilitated by digital technology capable of linking various types of
computers across different networks.
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Groupware are software products that support collaboration over networks among groups
of people who share a common task or goal.

Virtual reality is a system that delivers interactive computer-generated
3D graphics to a user through a head-mounted display.

CLASSIFICATION OF MULTIMEDIA

Multimedia may be broadly divided into:

LINEAR and NON-LINEAR categories. Linear active content progresses without any
navigation control for the viewer such as a cinema presentation. Non-linear content offers user
interactivity to control progress as used with a computer game or used in self-paced computer
based training. Hypermedia is an example of non-linear content.

Multimedia presentations can be LIVE or RECORDED. A recorded presentation may
allow interactivity via a navigation system. A live multimedia presentation may allow interactivity
via an interaction with the presenter or performer.

Multimedia presentations can be in electronic forms and in printed form.

MULTIMEDIA DATA ELEMENT

The following multimedia data elements and their various forms are described below:

1. Text: This is any of the signs or symbols that are used in writing or printing and which
represent a speech sound. Text mode refers to alphanumeric or character operation mode
which computer uses in displaying letters, numbers and other text characters.

2. Facsimile (or Fax): A letter or a message that is sent in electronic form down a
telephone line and then printed using a special machine called Fax Machine.

3. Document Images: These are electronic versions of printed images which are captured and
converted through electro photographic process.

4. Photographic Images: This refers to the production of permanent images by means of
the action of light on sensitized surfaces.

5. Geographic Information Systems Maps: A geographical information system (GIS) is a
computer system that synthesizes, analyses and displays many different types of
geographical data in an easily understandable form. Geographical maps are now being
made from computer databases. Such digital maps combine and clearly display different kinds
of information (e.g. census, pollutions, minerals, political affinities, residential patterns etc) for
a given geographical area.

6. Voice Commands and Synthesis: Voice is the sound (phonation) produced in the voice box
(larynx) by the expiration of air through vibrating vocal cords. It is defined in terms of pitch,
quality, and intensity or loudness. Voice command is the use of words and syntax of spoken
language to operate or control the computer. Voice synthesis refers to the ability of a
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10.

11.

12.

computer to produce spoken words.

Audio Messages: These are sounds which are recorded and probably broadcasted. Sound
is physical phenomenon that stimulates the sense of hearing; and in human beings,
hearing takes place whenever vibrations of frequencies between about 15 and 20,000 hertz
reach the inner ear.

Electronic circuits provide different functions to process audio signals into from analogue
to digital form and verse versa. Digital functions include the coding, storage an d
transmission of information-bearing in binary form, and the logic operations and
numerical processing performed in computers.

Music: This is the organized arrangement and movement of sounds made by instruments
or voices through a continuum of time in a pleasant or exciting way.

Graphics: This describes the process of information (objects, images, people, data
distributions, statistics etc) representations through drawing, pictorial illustrations, tables,
charts. The computer screen is divided into pixels which made it possible for lines and
characters to be drawn pixel by pixel on the computer screen. A pixel (picture element) is
the smallest unit (1 1000th)tiny spots of an image in a grid display on a computer screen.
Animated graphics produces the illusions of movement in graphic images using some. In a
computer, it is the simulation of movement produced by displaying series of successive images
on the screen.

Full-Motion and Video: This is the art of making motion-picture films (telling a story
using sound and moving pictures) and projecting such films onto a screen for a large audience.
Video is the process of recording and showing pictures along with sounds on television.

Holographic Images: These are 3D photographic images obtained using a lensless
photography technique called Hologram. Holograms are made by exposing a piece of film to
laser light, which is scattered by the object being holographed.

Fractals: These are geometric shapes that are complex and detailed in structure at any level
of magnification.

CATEGORIZATION OF MULTIMEDIA DATA
Multimedia data element can be categorized as presented in the table below

Category Description

Captured from real world
1. [Nature /Media

Synthesized by computers

Discrete: space-based only

Continuous Space-based and time based
E.g. animation, motion, video etc.

Source: Winter 1997

2. Spatial-temporal properties
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HISTORY OF MULTIMEDIA

This section presents an overview of the pioneering works through to the contemporary
contributions of people that have over many centuries labour to bridge the divide between the
arts, science and technological disciplines. ~ We shall study the work and ideas of artists who
have explored new interactive and interdisciplinary forms, as well as engineers and
mathematicians who have developed information technologies and influential scientific and
philosophical ideologies that have influenced the arts.

This broad historical analysis will help illuminate an understanding of the emerging digital arts
and its aesthetics, strategies, trends, and socio- cultural aspirations. Central to this analysis will
be an understanding of key concepts for the interpretation of evolving multimedia forms:
including integration, interactivity, hypermedia, immersion, and narratives.

Some of the important events in relation to Multimedia in Computing include:

Dates Events

15,000 -  [Prehistoric humans paint images on the walls of their caves

13,000BC

1895 Gugliemo Marconi sent his first wireless radio transmission
at Pontecchio, Italy

1901 Gugliemo Marconi detected radio waves beamed across the

Atlantic. Initially invented for telegraph, radio is now a

major medium for audio broadcasting. Television was the new media
for the 20th century. It brings the video and has since changed the world of
mass communications.

1906 Color photography became practicable concept.

1914 Silent movies incorporated multiple media by using film
and text captions together

1928 Walt Disney debuts the second short starring a mouse

named Mickey, and the first cartoon to use synchronized sound.

1928 — 1931 [Movies with sound replace silent movies

1930s Technicolor is introduced in film and most movies are
filmed in colour after

1937 Bell Laboratories had a breakthrough in creating dual sound
tracks on film.

1940 Fantasia was the first commercial movie with a complete
surround soundtrack in movies.

1945 Vannevar Bush wrote about Memex “As We May Think”

1960s Ted Nelson, created Xanadu, “a universal instantaneous
hypertext publishing network”.

1967 Nicholas Negroponte formed MIT Architecture Machine

Group (later in 1985 MIT Media Lab opens).
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1969 Nelson & Van Dam hypertext editor at Brown.
Birth of Arpanet (Internet) by US Military. DARPA
1971 The first E-mail was sent and received successfully,
1976 Negroponte’s  Architecture Machine Group proposed
Multiple Media to DARPA.
1977 Apple starts to gain control of the PC market with its
Macintosh Computers.
1980 Lippman & Mohl: Aspen Movie Map.
1981 IBM PC announced and captures market share in 18
months..
1983 Backer’s Electronic Book was launched.
1985 Negroponte & Wiesner opened MIT Media Lab.
1987 RCA’s David Sarnoff Labs’ announce Digital Video
Interactive.
1988 Apple “Knowledge Navigator” vision
1989 Tim Berners-Lee proposed the World Wide Web to CERN
(European Council for Nuclear Research).
1990 K. Hooper Woolsey, Apple Multimedia Lab opened.
1991 Motion Picture Experts Group.
World Wide Web debuts thanks to Tim Berners-Lee.
Apple  Multimedia Lab launched Visual Almanac, Classroom
MM Kiosk.
1992 MS Windows 3.1 is released
HTML debuts
The first M-bone audio multicast on the Net also debuts.
1993 The first graphical browser called MOSAIC which allows
us to view web pages containing IMAGES was launched by Marc
Andreessen, Erin Brina &Tim Clark at University of Illinois National
Center for Supercomputing Applications (NCSA).
1994 Jim Clark and Marc Andreesen launched Netscape
Creation of World Wide Web Consortium (W3C)
The Rolling Stones become the first major band to broadcast a
live performance over the Internet.
1995 Disney releases Toy Story, the first feature length computer
generated movie (77 minutes long, 4 years to make, 800,000 machine hours
to render).
JAVA for platform-independent application development launched.
1996 Portable Network Graphics (PNG) was launched.Microsoft, Internet
Explorer was launched. Affordable digital cameras widely available.
1997 HTML 4.0
1998 XML 1.0

Google Search Engine operates by Larry Page & Sergey
Brin was launched.
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1999 XSLT 1.0 and Xpath 1.0
Napster debuts, allowing users to download and share
MP3s.

2000s Integration of computer, memory storage, digital

datacamcorders, MP3 players, IPods, speakers, telephones, HD TV and
other technologies explodes.

2001 MPEG-7, JPEG 2000, SVG.

2002 Intellectual property and JPEG 2000

The MULTIMEDIA COMPUTER (MPC) was the next major landmark in the history of
multimedia, appearing in the early 1990s. The MPC was a breakthrough in terms of its
compactness, price and user-friendliness. Most PCs that are currently available can be
classified as multimedia computers. These following components are essential features of
an MPC:

a soundcard

twin loudspeakers or a set of headphones

a microphone

a CD-ROM drive - but modern MPCs are likely to be equipped with a combination CD-
ROM / DVD drive as standard.

There were earlier computers that qualified as multimedia computers, e.g. the Apple Mac and
the Acorn Archimedes in the UK, but the dominant multimedia computer is the MPC. Apple
computers appear to have a commanding position in the print and graphic design industries, while
Acorn computers only ever gained a foothold in the UK schools sector and finally lost their market
share to the MPC.

Now we have multimedia on the Web. It's a growing area but has not yet completely
supplanted CD-ROM or DVD technology. Web-based multimedia may offer more in terms of
presentation rather than interactivity, and broadband accessis essential in order to
avoid hiccups in delivering sound and video.
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INTRODUCTION

Multimedia components are used in combination with the interactive and hyperlink
features.

DEFINITIONS

Hyperlinking is an index which allows for jumping around to different sections of
electronic documents such as e-books, webpages, etc.

Hyper Text Mark-up Language (HTML) has features that allow a person to build
hyperlinks to other webpages or location on the same page.

Hypertext is a text which contains links to other texts and is therefore usually non-linear.
It is the general term applied to ‘clickable’ text. Once a user click on a word or words,
he is then taken to a different document or another area of the current document.

HYPERMEDIA

Hypermedia refers to multimedia systems that include nonlinear structure of
information units, events, and discrete media. Hypermedia can be considered as one
of the multimedia applications which combined materials in many media—text,
graphic art, sound, video and animation; are delivered via digital computer or other
electronic means, and provides a linked structure through which a user can navigate
through elements.

Hypermedia is a general term applied to ‘clickable’ media. Once a user clicks on a
particular word or graphic, he is then taken to other text, graphics, sound files, animation
or moving video. The World Wide Web is a classic example of hypermedia, whereas a
non-interactive cinema presentation is an example of standard multimedia due to the
absence of hyperlinks.

11
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Most modern hypermedia is delivered via electronic pages from a variety of systems

including Media players, web browsers, and stand- alone applications. Audio
hypermedia is emerging with voice command devices and voice browsing.

Hypermedia development tools

Hypermedia may be developed in a number of ways. Any programming tool can be used
to write programs that link data from internal variables and nodes for external data files.
Multimedia development software such as  Adobe Flash,  Adobe Director,
Macromedia Authorware, and MatchWare Mediator may be used to create stand-alone
hypermedia applications, with emphasis on entertainment content. Some database software
such as Visual FoxPro and FileMaker Developer may be used to develop stand-alone
hypermedia applications, with emphasis on educational and business content management.

Hypermedia applications may be developed on embedded devices for the mobile and
the Digital signage industries using the Scalable Vector Graphics (SVG) specification
from W3C (World Wide Web Consortium). Software applications such as Ikivio
Animator and Inkscape simplify the development of Hypermedia content based on
SVG. Embedded devices such as iPhone natively support SVG specifications and may
be used to create mobile and distributed Hypermedia applications.

Hyperlinks may also be added to data files using most business software via the limited
scripting and hyperlinking features built in. Documentation software such as the
Microsoft Office Suite allows for hypertext links to other content within the same file,
other external files, and URL links to files on external file servers. For more emphasis on
graphics and page layout, hyperlinks may be added using most modern desktop publishing
tools. This includes presentation programs, such as Microsoft Powerpoint, add-ons to
print layout programs such as Quark Immedia, and tools to include hyperlinks in PDF
documents such as Adobe InDesign for creating and Adobe Acrobat for editing.
Hyper Publish is a tool specifically designed and optimized for hypermedia and hypertext
management. Any HTML Editor may be used to build HTML files, accessible by any web
browser. CD/DVD authoring tools such as DVD Studio Pro may be used to hyperlink
the content of DVDs for DVD players or web links when the disc is played on a
personal computer connected to the internet.

Hypertext

In contrast to traditional document, hypertext and hypermedia have as their major
property, a non-linear information link. A hypertext structure is a graph, consisting of
nodes and edges. The nodes are the actual information units. The edges provide links to
other information units. One can navigate through a document by clicking the edges
(arrows or links). The root of the arrows are known as anchors. The links serve as a
navigation aid allowing users to access information quickly and to navigate from one
topic to another in a nonlinear manner.

12
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Hypertext refers to a document containing purely text, or sometime some images but
no continuous media, with non-linear links, while there have been a number of hypertext
systems before the recent bloom of World Wide Web, e.g., Apple’s Hypercard.

p

Multimedia /\] H]:u:'bh
NS

Hypermedia

Document Structure

Document structure is the logical organization of the information, i.e., the contents.
Traditional documents, such as a book, may contain only text and still images. They
can be organized linearly. The logical structure will be, for example, chapters,
sections, subsections, paragraphs. When documents are exchanged, everything about the
document has to be transferred. These include the contents, the structure and the
presentation.  Therefore, it requires some way of describing the structure and the
presentation of the document along with the contents.

Document Markups

When exchanging hypertext documents, we need to transfer the contents as well as
the structure and the presentation of the documents. Document markups allow us
to specify the document structure and how it is presented by inserting commands into
the document. These are known as markups. There are in general two kinds of
markups: a) logical and b) visual.

The logical markups marks the document elements according to their functions and
relations with other elements, e.g., chapter, section, paragraph. It does not tell how the
elements looks. The advantages of logical markups are:

oThe document structure is explicit, thus the organisation of information is clear.

O It is easy to maintain the consistent look of the document.
O It requires a more powerful process to render the document.

The visual markups defines how the elements are rendered, for example, a chapter title is

formatted in Helvetica Bold 24 point, while a section heading is formatted in Times

Roman Bold 20 point. With visual markup, the logical structure is lost. The visual
13
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effects of the elements are explicit.

o It is easier to keep the fidelity.
o It is easier to render the document.

o It is hard to maintain the consistent look of the document.

A document can be viewed in these two aspects at the same time. In the diagram on the
right, if we start from the top, we will see the logical structure of a document. If we start
from the bottom, we will see the presentation aspect of the document.
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chaprer —u— Logical structure
froee
— chaprer
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Hypermedia can be thought of as one of the multimedia applications which
combined materials in different media—text, graphic art, sound, video and animation.
Hypermedia applications are delivered via digital computer or other electronic means,
and provides a linked structure through which a user can navigate through elements.

of the information
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INTRODUCTION

Interactive multimedia implies allowing an end user some control over what elements
to present and when. Thus, it allows user-response to alter the way the presentation
proceeds. For someone to truly learn how to use a program or a product, it's essential
that they actually use it. Interactivity allows each user to actively participate in the
viewing process, instead of passively watching the material presented. The nature of your
material determines the amount of interactivity you should use. The desktop computer is
currently a popular vehicle for interactive multimedia presentation.

Interactive Multimedia can be defined as an integration of relationship between multimedia
and interaction. It is a multimedia system in which related items of information are
connected and can be presented together. It involves combination of the followings:

e knowledge and information
e acollection of technologies

e collection of multimedia components (modality, channels of communication,
medium)

e aset of collaborative systems
e virtual environments

INTERACTIVE MULTIMEDIA

Interactive multimedia is a type of collaborative media and refers to media that
allows for active participation by the recipient, hence interactivity. Traditional information
theory would describe interactive media as those media that establish two-way
communication. In media theory, interactive media are discussed along their cultural
implications. The field of human-computer interaction deals with aspects of
interactivity and design in digital media. Other areas that deal with interactive media are
new media art, interactive advertising and video game production.

15
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While much traditional analog electronic media and print media qualifies as
interactive media, the term is sometimes misunderstood as exclusive to digital media.
The significant increase in possibilities for interactivity (especially over vast
distances) brought by the internet boosted the availability of digital interactive media.
Still, e.g. language in face-to-face communication would formally belong to the category
of interactive media.

Interactive media are often designed by information designers. As all media they rely
on communication. In the case of e.g. computer games this is visual, acoustic, and
haptic communication between the user (player) and the game. In mobile telephony, the
communication happens between two people and is purely acoustic at the first
glance. Yet, according to media theory the cultural implications of the medium have to
be taken into account. Thus, aspects like constant availability, customization of the mobile
phone and Short Message Service are also part of the interactive medium called
mobile telephony. Media restrain from being translated to technological entities.

COMPONENTS OF INTERACTIVE MULTIMEDIA
The components of interactive multimedia include the followings:

e Asset — an object which encapsulates a single piece of ‘media’ (e.g. video, sound
clip, graphic)

e Information — the collection of data by a particular encoding

e Knowledge — the interpretation and understanding of information

Metamedia

Metamedia refers to new relationships between form and content in the development of
new technologies and new media. Metamedia utilizes new media and focuses on
collaboration across traditional fields of study, melding everything from improvisational
theatre and performance art, to agile, adaptive software development and smart mobs.
Succinctly, it refers to the theoretical effects of mass media and focus on provision of
flexible online environment for creating and sharing rich media documents for learning on
core humanities subjects.

UNIT 4 ISSUES IN MULTIMEDIA SYSTEMS CONTENTS

16



CIT 735 MODULE 1
1.0  Introduction
2.0  Objectives
3.0  Characteristics of a Multimedia System
3.1  Challenges for Multimedia Systems
3.2 Challenges of Multimedia System Design
3.3 Desirable Features for a Multimedia System
3.4 Components of a Multimedia System
3.5  Trends in Multimedia
3.6 Multimedia Delivery
3.7  Delivery of Multimedia Applications
4.0 Conclusion
5.0 Summary
6.0  Tutor-Marked Assignment
7.0  References/Further Reading

A Multimedia System is a system capable of processing multimedia data and
applications. It is characterised by the processing, storage, generation,
manipulation and rendition of Multimedia information.

CHARACTERISTICS OF AMULTIMEDIA SYSTEM
A Multimedia system has four basic characteristics:

1. Multimedia systems must be computer controlled.

2. Multimedia systems are integrated. Multimedia = multi X separate medium.

3. The information they handle must be represented digitally. All information is
ONLY in the images or video.

4. The interface to the final presentation of media is usually interactive.
Query by example is best access method. Editing of media is almost always off-
line.

CHALLENGES FOR MULTIMEDIA SYSTEMS

Supporting multimedia applications over a computer network renders the application
distributed. This will involve many special computing techniques -- discussed later.

Multimedia systems may have to render a variety of media at the same instant -- a
distinction from normal applications. There is a temporal relationship between many
forms of media (e.g. Video and Audio. There are two forms of problems here

1. Sequencing within the media -- playing frames in correct order/time frame in
video
2. Synchronisation -- inter-media scheduling (e.g. Video and Audio). Lip

synchronisation is clearly important for humans to watch playback of video and
audio and even animation and audio. Ever tried watching an out of (lip) sync
film for a long time?

The key issues multimedia systems need to deal with here are:
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e How to represent and store temporal information.
e How to strictly maintain the temporal relationships on play back/retrieval
e What process are involved in the above.

Data has to represented digitally so many initial source of data needs to be digitise --
translated from analog source to digital representation. This will involve scanning
(graphics, still images), sampling (audio/video) although digital cameras now exist for
direct scene to digital capture of images and video.

The data is large several Mb easily for audio and video -- therefore storage, transfer

(bandwidth) and processing overheads are high. Data compression techniques very
common.

CHALLENGES OF MULTIMEDIA SYSTEM DESIGN

. Host computing power requirement

. Data Storage and Management requirements
. Human Interface Usability requirements

. Network latency and throughput requirements

DESIRABLE FEATURES FOR A MULTIMEDIA SYSTEM
Given the above challenges the following features are desirable (if not a prerequisite) for a
Multimedia System:

1. Very High Processing Power: needed to deal with large data processing and real
time delivery of media.

2. Multimedia Capable File System: needed to deliver real-time media -- e.g.
Video/Audio Streaming. Special Hardware/Software needed e.g RAID technology.

3. Data Representations/File Formats that support multimedia: Data
representations/file ~ formats should be easy to handle yet allow for
compression/decompression in real-time.

4. Efficient and High 1/0O: input and output to the file subsystem needs to be efficient
and fast. This needs to allow for real-time recording as well as playback of data.
e.g. Direct to Disk recording systems.

5. Special Operating System: to allow access to file system and process data
efficiently and quickly. This needs to support direct transfers to disk, real-time
scheduling, fast interrupt processing, 1/0 streaming etc.

6. Storage and Memory: large storage units (of the order of 50 -

7. 100 Gb or more) and large memory (50 -100 Mb or more). Large Caches also required
and frequently of Level 2 and 3 hierarchy for efficient management.

8. Network Support: Client-server systems common as distributed systems common.

9. Software Tools: user friendly tools needed to handle media, design and develop
applications, deliver media.

COMPONENTS OF A MULTIMEDIA SYSTEM
Now let us consider the Components (Hardware and Software) required for a multimedia
system:
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1. Capture devices include Video Camera, Video Recorder, Audio Microphone,
Keyboards, mice, graphics tablets, 3D input devices, tactile sensors, VR
devices. Digitising/Sampling Hardware

2. Storage Devices include Hard disks, CD-ROMs, Jaz/Zip drives, DVD, etc

3. Communication Networks include Ethernet, Token Ring, FDDI, ATM, Intranets,
Internets.

4. Computer Systems include Multimedia Desktop machines, Workstations,
MPEG/VIDEO/DSP Hardware

5. Display Devices include CD-quality speakers, HDTV,SVGA, Hi- Res monitors,
Colour printers etc.

TRENDS IN MULTIMEDIA

Current big applications areas in Multimedia include:

1. World Wide Web: Hypermedia systems -- embrace nearly all multimedia
technologies and application areas. Ever increasing popularity.

2. MBone: Multicast Backbone: Equivalent of conventional TV and Radio on the
Internet.

3. Enabling Technologies: developing at a rapid rate to support ever increasing
need for Multimedia. Carrier, Switching, Protocol, Application, Coding/Compression,
Database, Processing, and System Integration Technologies at the forefront of this.

MULTIMEDIA DELIVER

Multimedia contents can be accessed or delivered via videotape, hard- disk, CD-ROM
or over a distributed network such as the World Wide Web. Also it can be non-
interactive or interactive, or printed multimedia. Multimedia and the Internet
require a completely new approach to writing. The style of writing that is appropriate
for the 'on- line world" is highly optimized and designed to be able to be quickly
scanned by readers.

A good site must be made with a specific purpose in mind and a site with good
interactivity and new technology can also be useful for attracting visitors. The site
must be attractive and innovative in its design, function in terms of its purpose,
easy to navigate, frequently updated and fast to download. When users view a page,
they can only view one page at a time. As a result, multimedia users must create a
‘mental model of information structure’.

Patrick Lynch, author of the Yale University Web Style Manual, states that users need
predictability and structure, with clear functional and graphical continuity between the
various components and subsections of the multimedia production. In this way, the
home page of any multimedia production should always be a landmark, able to be
accessed from anywhere within a multimedia piece.

Delivery of Multimedia Applications
Multimedia applications can be delivered via the World Wide Web or on CD-ROMs/DVD.

| \World Wide Web ICD-ROM/DVD
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Access Time [Can experience slow connection speeds. |(Content are  viewed immediately
the CD/DVD is inserted into the
Access time depends on internet bandwidthCD- ROM/DVD drive
and available resources on the local
computer.
Ability to It is easy to update material on web. Content cannot be changed but
change can be recreated and redistribute
content New updates can be instantly accessed offto audience.
the web

Computer based delivery of delivery multimedia applications include Video Games,
Interactive Web Applications, CD ROM discs and Informational kiosks. Computer-based
multimedia applications integrate the various media components and allow interactivity
and hyperlinking.

Web-based multimedia applications are  faced with  two  major challenges,
namely link fossilization, and server and network overload. Link fossilization challenges
include when the host server has changed, the applications is no longer residents at the
host, or when a host contain only an outdated version of the applications. The challenges
related to network and server overload include when large size of multimedia applications,
users are not informed of their network capabilities in relation to application file
sizes, when users and authors are not conscious of network implications, and sub-
optimally designed servers and protocols (same applications being transferred many
times between a server and a client size).

UNITS MULTIMEDIA TOOLS: HARDWARE

CONTENTS
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MULTIMEDIA HARDWARE

Certain minimum hardware specifications are desirable for a use to run multimedia
applications on a computer. Modern computers are normally equipped with all the essential
components as standard, but the variety is huge and careful choices have to be made. These
are typical minimum hardware specifications:

A fast multimedia PC running at 1000 MHz or higher.
At least 2GB of RAM (memory). The more RAM the better!
Hard disk drive with at least 100GB storage capacity.

Monitor. Buy the best-quality monitor you can afford.

Soundcard (an expansion card that provides both input and output).
Loudspeakers or headphones.

Microphone.

Video card / graphics card.

CD-ROM drive.

DVD drive.

Soundcard

An adequate soundcard is essential for multimedia. Modern multimedia computers are
fitted with soundcards as standard, so the choice of soundcard may already have
been made for you. A wuser should be familiar with soundcard controls under the
Windows operating system in other to be able to adjust the output volume of the
soundcard and the input sensitivity of the microphone.

Loudspeakers/Headphones

Speakers or headphones are essential for listening to sound recordings. When purchasing

speakers it is worthwhile checking that they have their own inbuilt amplification system.

The sound level of all speakers or headphones can be controlled under the Windows

operating system, but good speakers have a volume control knob that also enables the user

to adjust the volume manually. Headphones can be integrated with a microphone - the so-
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called pilot's headset that is used in language laboratories. Stereo speakers or headphones
are advisable for most multimedia applications.

Microphone

The importance of selecting the right kind of microphone is often not appreciated by
ICT technicians. For good quality sound recordings the language teacher needs a
high-quality  microphone. = A dynamic microphone (also known as a karaoke
microphone) is satisfactory but provides a softer signal than a condenser microphone
(also known as a powered microphone).

The level of the input signal to the microphone can be controlled under the Windows
operating system. A common mistake made by newcomers to multimedia applications is
a failure to set the input signal control properly so that very faint sound - or no sound at all
- Is emitted when playing back recordings made by the user. It is advisable to purchase a
microphone that has its own on/off switch.

Video card/Graphics card

The terms video card and graphics card are used to mean much the same thing. The term
card in this context is jargon for an electronic circuit board. You will not be able to
see the video card from outside the computer. All that is visible is the rear of the
card is the socket into which you plug the monitor. It is important to know what kind
of video card your computer is equipped with, as this affects what the monitor can
display. When you purchase software make sure that your computer has a video card
that is compatible with the software you wish to use. Some software will only work
on computers equipped with video cards with high specifications.

CD-ROM drive

CD-ROM stands for Compact Disc Read Only Memory. A CD-ROM is an optical
disk onto which data has been written via a laser - a process often referred to as "burning
a CD". A CD-ROM looks much the same as an audio CD but can contain text, sound,
pictures and motion video.

A CD-ROM drive - which is standard on modern multimedia computers

- is essential for running multimedia applications. CD-ROMs are the commonest storage
media for multimedia applications.

Modern computers are now usually equipped with a combination drive that enables both
CD-ROMs and DVDs to be played and recorded - as well as playing and creating
audio CDs and movies. A CD-ROM drive can also play standard audio CDs, so you
can listen to your favourite music while you work or follow a language course
supplied on audio CD - but most computer technicians keep quiet about this as they
don't want their computer lab turning into a discotheque or language lab! It is possible to
extract or copy tracks from an audio CD and save them to your computer's hard disk
as audio files, which can then be played, edited, written back to another CD, or saved
to an iPod or similar mobile player. This process is often referred to as "'ripping a CD"".
CD-ROM drives are available in a variety of different speeds, the speed being described
thus: 12x (12-times), 24x (24-times), etc. This indicates the speed at which data can be
pulled off the CD-ROM drive - the so-called spin-rate - 150 kilobytes per second being
the notional original
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1x spin-rate - long since superseded. A high spin-rate helps speed up data transfer,
which is crucial when playing sound or video. A low spin- rate may cause hiccups
when audio and video recordings are played. CD-ROMs work fine on stand-alone
computers but networking CD- ROMs containing large amounts of sound and video can
be problematic. Although it is technically possible for a limited number of network users
to access data on the same CD-ROM, the success of this depends on a number of technical
factors that are too complex to discuss here, and you are therefore advised to consult
your network manager.

CD-ROMs can store at least 650 megabytes of data. Compared to other storage media, the
CD-ROM's storage capacity is impressive. A single CD-ROM can comfortably
accommodate 500 medium-length novels, a

12-volume encyclopaedia, the complete works of Shakespeare, or a whole year's
edition of a newspaper. It is this enormous storage capacity that makes CD-ROMs
attractive. When graphics and audio and video recordings are stored in computer-
readable format they take up much more space than text, and they can only be made
available to consumers in reasonable quantities if they are stored on CD-ROM or DVD.

Once written, the data on a CD-ROM can be fixed and rendered unalterable, hence
the term Read Only - but modern computers are usually equipped with a CD
read/write drive that enables new material to be stored on a special kind of CD-ROM:
CD-R (recordable) or CD- RW (rewriteable). A CD-read/write drive is useful for
making backups and storing your own multimedia materials. Blank CD-Rs or CD-
RWs can be bought from computer media suppliers at a relatively low cost. You can
store data on CD-Rs using a read/write drive, adding to it until it is full, and then you
can format the CD-ROM so that it is fixed and can be read by a standard CD-ROM
drive. You can also store data on CD-RWs in the same way, but these disks can only be
read by a CD read/write drive. The advantage of CD-RWs is that they can be erased
and used over and over again, but now that the cost of blank CD-Rs has fallen to such a low
level it is questionable how useful CD-RWs are. It is also possible to create or copy audio
CDs on a CD read/write drive.

Multimedia CD-ROMs are designed mainly for use on stand-alone computers. This is
because the main target of CD-ROM manufacturers is the home user.

DVD drives

Most modern PCs come equipped with a DVD drive. DVDs (Digital Video Discs) -
or, more accurately, Digital Versatile Discs - are relative newcomers to the multimedia
scene. They look just the same as CD-ROMSs and audio CDs, but they are much more
versatile and can store much more data. They are already in widespread use to store
movies that can be played back on domestic TV sets. DVDs can also be used to store
computer data, which can be read by a computer equipped with a DVD drive.

Modern multimedia computers usually come equipped with a DVD read/write drive or a
combination drive that can read and write to CD- ROMs too, as well as playing and
creating audio CDs.

First, an important distinction:

e A DVD-player is the name given to the device used in home entertainment
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systems to play back video and audio. A DVD- player can play:

o DVD-Video discs - also referred to as DVD-Movie discs: e.g.
containing, full-length feature films, videos of concert performances, etc;.

o audio CDs.

e ADVD drive, as fitted in a multimedia computer, can play:

o DVD-ROM discs, which consist of combinations of computer
programs and high-quality motion video;

o DVD-Video discs - also referred to as DVD-Movie discs: e.g. containing,
full-length feature films, videos of concert performances, etc;

o CD-ROMs;

o audio CDs.

A DVD-player cannot normally be used to play DVD-ROM discs - but bear in mind
that this technology is in the process of coverging and moving towards fully
integrated systems, including DVD read/write players that can be linked to TV sets.

The main advantage of all types of DVDs is that they offer very high quality video
and sound. In this respect they have finally caught up with

- and surpassed - the video quality offered by older 12-inch laserdiscs. Their capacity is
impressive - up to 25 times the storage capacity of a CD-ROM, which means that a
DVD can comfortably hold a full-length movie. Most modern computers can play DVD-
Video discs and DVD- ROM discs.

DVD-Video discs

Standards for DVD-Video are still in the process of settling down. An annoying aspect of
DVD-Video is that the world is carved up into six regions, also called locales, each of
which has its own DVD standard. DVD-Video discs are regionally coded - look for a
small standardized globe icon on the packaging with the region number superimposed on
it. If a disc plays in more than one region it will have more than one number on the
globe. The current six regions are:

1 USA, Canada
2 Western Europe, Japan, South Africa
3. South East Asia

4. Australia, Spanish America
5 Russia, Eastern Europe, Africa
6. China

A DVD-Video disc coded for Region 1 (USA, Canada) will not play on a DVD player
sold in Region 2 (Western Europe, Japan, South Africa). When you buy a computer
equipped with a DVD drive, the region will have been pre-set, but you can change it
via Windows. The problem is that you cannot keep doing this: you normally only
have five chances (more on some systems) to change regions! There are various
reasons for this non-standardisation, one of them being that movie producers release
movies at different times in different regions and in different variations. There are various
ways of getting round the problem of non- standardisation - but this is beyond the scope
of this introduction and you are advised to consult someone who is technically competent
in this area.
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DVD-Video discs have impressive advantages. You can play back a full movie with 8-
channel surround-sound cinema effects. You can easily jump to a particular
sequence (a  scene or chapter), and DVD-Video discs often offer alternative
soundtracks in different languages, subtitles (i.e. subtitles in a language other than the
one in which the film was recorded), closed captions (i.e. subtitles in the same
language as the one in which the film was recorded), and information about the director
and cast, as well as the possibility of previewing and playing your favourite scenes over
and over again.

DVD-ROM discs

DVD-ROM discs are not subject to the same geographical restrictions as DVD-Video
discs. They only run on computers equipped with a DVD drive and cannot be played on a
domestic DVD player - but, having said that, DVD technology is in the process of
setting down and moving towards fully integrated systems. DVD-ROM discs
combine computer programs and movies and are becoming increasingly flexible as an
instructional medium, especially for Modern Foreign Languages.

Each DVD is divided into six sections:

i. Video & Script: The whole movie can be viewed in full-screen mode without
subtitles or in small-screen mode with subtitles and an optional rolling script. If the
learner wishes to view a particular scene and play it over and over again, it can be
selected from a menu.

ii. Movie Quiz: The learner takes part in a quiz on the movie, pitting his/her wits
against a "virtual" competitor - a character who has already appeared in another
EuroTalk series.

iii.  Record Yourself: The learner can choose a character in a short

clip from the movie and record his/her own voice, which is then substituted for the
character's voice.

iv.  Dictionary: The learner can look up a word, which is then spoken aloud and
illustrated with a still picture from the movie.

v.  Word Search: The learner can look for an example of a word in

use. A short clip containing the word will then play.

vi.  Activities: These consist of a four types of interactive exercises:

oVocabulary: The learner attempts to match a spoken word with a still picture

oMissing Word: A gap-filling/multiple-choice drag-and- drop exercise in which the
learner attempts to match a blanked-out word in the movie subtitle with a selection of
possible words that appear below the subtitle.

oSpelling: An activity which is similar to Missing Word, except that the learner has to
drag the word letter-by-letter into the gap in the subtitle.

oWhat's the next line? A multiple-choice exercise in which a short clip from the
movie is played and the learner has to anticipate the next line.

3.7 Scanners

A scanner is a device that copies hard copy information (printed page, graphic image,
photograph etc) into digital data, translating the information into a form a computer
can store as a file. Thus it is possible to make a digitised copy of a printed page, graphic
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image or photograph. Simple graphic images are usually stored in a format known as
GIF. Photographs are usually stored in a file format known as JPEG or JPG and they
can then be printed on a colour printer, sent as an email attachment to a friend or
colleague, or incorporated into a website.

Scanners do not distinguish text from graphic images and photographs, so you cannot
use a word-processor to edit directly a printed page that has been scanned. To edit
text read by an optical scanner, you need Optical Character Recognition (OCR)
software to translate the image into 'real text, i.e. a format that can be read by a
word-processor. An OCR machine scans individual characters, isolates salient features,
and then some decision is made as to what letter or other character lies below the
reader. When the characters actually occur as part of natural- language text, it has long
been recognized that contextual information can be used to assist the reader in resolving
ambiguities. Most optical scanners today come bundled with OCR software.

The most popular type of scanner is known as a flatbed scanner. This looks a bit like
a photocopier and works in a similar way. You lay the picture or page containing the text
to be scanned on a glass plate, start the scanning software and watch the digitised
image appear on screen. The image can then be saved as a file on your hard disk. Text
saved as an image can then be converted into "real text" with the aid of OCR
software. OCR software does not work 100%, as broken characters and faded characters
are liable to be misread, but surprisingly good results can be achieved - and it certainly
beats typing!

Some scanners are small hand-held devices that you slide across the paper containing
the text or image to be copied. Hand-held scanners are fine for small pictures and
photos, but they are difficult to use if you need to scan an entire page of text or larger
images.

3.8 Other Hardware Tools

These include the followings:

a. Audio digitizer — pair of A-D and D-A converters

b. Wavetable synthesis — has the capability of producing sound

c. Mixer — combines the above 2 signals with mixing audio from a CD-ROM or DVD-
ROM

d. 3 jacks: - Microphone input, Line in from stereo, TV, radio, etc. and Speaker output

e. PC Camera (Webcam) — allows a user to see people at the same time they
communicate on the Internet as well as edit videos from a video camera or a VCR,
create a move from still photographs and videos, and take digital photographs
automatically at preset times or when the camera detects motion. Typically, a video
in plug is present on the camera while some models will attach to USB ports.

f. Digital Cameras — like a regular camera except images are stored to a floppy disk, PC
Card or internal memory.

g. Display Device — (monitor and video card) allow for the display of visual
multimedia components
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h. Televisions — must have an NTSC converter to change computer’s digital output to
the television’s analog input. HDTV’s don’t require the converter.

I. Multimedia (Data) Projector — a device which connects directly to the
computer with a cable and uses its own light source to display a multimedia app or
presentation

J. Video Capture Card - enables you to connect a video camera or
VCR to a computer and manipulate the video input.
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UNIT 6 MULTIMEDIA TOOLS: SOFTWARE

Media players

Software that you require for running multimedia applications will probably be
supplied with your multimedia computer. A media player should automatically spring
into action when your computer needs to play an audio or video clip. A media
player is in effect a "virtual" playback machine, complete with Play, Stop, Pause, Fast
Forward, Fast Reverse and Volume Control buttons. Media players installed on your
computer can also act as a plug-in when an audio or video clip is accessed onthe
Web.. Examples of media players include:

1. iTunes is used for playing and organizing multimedia files and transferring them
to an iPod or similar mobile devices. iTunes also offers an extensive online
library of musicrecordings and video recordings. The Open University in the
UK has made some of its language-learning materials available via
iITunes. http://www.apple.com/itunes/

2. VLC Media Player: A cross-platform (PC and Mac) media player that plays
virtually any type of media file: http://www.videolan.org/vic/

3. QuickTime: http://www.apple.com/quicktime/ - for playing audio and video
files.

4. RealPlayer: http://uk.real.com/realplayer/ - for playing audio and video files.

5. Windows Media Player: Normally bundled with the Windows operating system.

CODECs

CODEC is short for COmpressor / DECompressor or COder /DECoder. A
CODEC is software that is used to compress or decompress a digital audio or
video file. CODECs are additional pieces of software that operate in conjunction with
different media players, and certain types of audio and video recordings will only play
back if the relevant CODEC is running in conjunction with the media player that
you are using.

A CODEC can consist of two components, an encoder and a decoder. The encoder
compresses the file during creation, and the decoder decompresses the file when it is
played back. Some CODECs include both components, while other CODECs include
only one. CODECSs are used because a compressed file takes up less storage space on your
computer or on the Web.

When users play an audio or video file in media player, the media player will use a
CODEC to decompress the file. The extension WAV, MP3, AVI, WMA, WMV or
MPEG is not a guarantee that an audio or video file can be played in the media
player, as the file may have been compressed using a CODEC that is different
from those already installed on your computer.

3.2.1 Digital Language Labs

Digital language labs incorporate a media player/recorder, but go one step further
insofar as they offer, in digital format, the same kind of audio-interactive facilities
found in a traditional language lab, including teacher monitoring facilities and video
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playback. The following businesses supply digital language labs:

CAN-8 VirtualLab: http://www.can8.com

Keylink Computers: http://ds.dial.pipex.com/keylink

Melissi Multimedia: http://www.melissi.co.uk

Robotel: http://www.robotel.com

Sanako: http://www.sanako.com

SANS (Software And Network Solutions), Sony Licensor:
http /lwww.sansinc.com

Sun-Tech: http://www.suntechgroup.com

Televic Education (Artec): http://www.televic.com

3.3 DVD media players

If a computer is equipped with a DVD drive it will need a media player that enables
DVDs to be played. It is likely that your computer will have a DVD-compatible media
player pre-installed if you have purchased a computer with a DVD drive. But many
other media players will also play DVDs.

3.4 Multimedia Editing Software
A user that intends to develop multimedia applications, there is need for additional
editing software to create and edit images, audio files and sound files - collectively
known as assets. A selection of packages for creating and editing images, sound and video
is described below.

Adobe Photoshop and Adobe Illustrator: http://www.adobe.com/uk/

Corel Paint Shop Pro and Corel Painter: http://www.corel.com

LView Pro: http://www.lview.com

When using the above packages, it is important that to be aware of the different formats
in which images can be stored on a computer. Most image editing packages allow
you to save images in different formats and to convert from one format to another. The
commonest formats are:
-BMP: Bitmap format. This is the standard format used by Windows Paint.
Images stored in this format tend to be rather large, however.
- EPS: Encapsulated Postscript format. An image file format that is used mainly for
printing images on Postscript printers.
« GIF: Graphic Interchange Format. This format is commonly used for storing simple
graphics on the World Wide Web, e.g. line drawings and maps. GIF files use a palette
of 256 colours, which makes them practical for almost all graphics except photographs.
Generally, GIF files should be used for logos, line drawings, icons, etc, i.e. images
that don't contain a rich range of colours. A GIF file containing a small number of
colours tends to be small, but it will be big if the image has a wide range of colours,
e.g. a photograph. GIF files are commonly used for storing images on the Web. GIF
files are also suitable for storing animated images.
«JPG (or JPEG): Joint Photographic Expert Group format. The JPEG/JPG format
uses a palette of millions of colours and is primarily intended for photographic
images. The internal compression algorithm of the JPEG/JPG format, unlike the
GIF format, actually throws out superfluous information, which is why JPEG/IPG
files containing photographic images end up smaller than GIF files containing
photographic images. If you store an image, say, of a flag containing just three
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colours in JPEG/JPG format it may end up bigger than a GIF file containing the same
image, but not necessarily a lot bigger - it depends on the type and range of
colours it contains. JPEG/JPG files containing photographic images are normally
smaller than GIF files containing photographic images. JPEG/JPG files are
commonly used for storing images on the Web.

‘TIFF or TIF: Tag Image File Format. Files stored in this format give a high-quality
image but they are huge.

3.5 Scanning and OCR software

Most image editing packages also include software for acquiring images from scanners
above. When you buy a flatbed scanner it is normally supplied with software for
scanning images from photographs or other printed media, and with optical character
recognition (OCR) software for scanning in texts and converting them into a format
that can be read with a word-processor and then edited.

3.6  Sound recording and editing software
Making and editing sound recordings and turning them into podcasts are not difficult.
These are some of the tools available for making sound recordings:

-Adobe Audition: The "industry standard”, the successor to Cool Edit:
http://www.adobe.com/uk/

- Audacity (freeware): Allows for all the basic features of editing, but you need to
download addtional software in order to create MP3 files:
http://audacity.sourceforge.net. There is a tutorial on the Audacity site on how to use
the software. Joe Dale's Blog contains many references to audio recording using
Audacity: http://joedale.typepad.com. Joe has also set up a comprehensive set of

links to tutorials on Audacity: http://delicious.com/joedale/audacity

- GoldWave: http://www.goldwave.com

« NCH Swift Sound: A wide range of useful tools, including some downloadable
freeware: http://nch.com.au

-Sound Recorder - supplied with Windows. Rather primitive, with only basic
operations. Suitable only for introducing language teachers to audio recording and
editing.

It's easy to make recordings directly onto the hard disk of a computer, but it is
preferable to make them first on a portable recorder (analogue or digital) and then upload
them to the computer using a connection lead. See the range of audio recording
devices offered by Olympus and iRiver:

Olympus: http://www.olympus.co.uk/voice/

iIRiver: http://www.iriver.com
When using the above editing packages, it is important that you are aware of the
different formats in which sound can be stored on a computer. Most sound editing
packages allow a user to save images in different formats and to convert from one format
to another. The commonest formats are:

+MP3: The standard format for storing sound files, especially music, on the Web.
MP3 is the form favoured for podcasting. The advantage of this format is that it
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compresses the sound - therefore saving space - without a significant loss in quality.
MP3 is a variant of MPEG .
- MP4 AAC: Abbreviation for MPEG-4 Advanced Audio
Coding. The MP4 AAC file format is used to store audio files ina more manageable
size without affecting the quality. MP4
AAC's best known use is as the default audio format of Apple's
iPhone, iPod and iTunes media player. See also the reference to
MPEG-4 Advanced Video Encoding.
«WAYV: Until recently, the commonest format. Produces high- quality sound but
takes up quite a lot of space.
- WMA: Windows Media Audio is Microsoft's own audio
encoding format that is starting to gain popularity due to its high- quality output at lower
file sizes.

Use Audacity rather than Windows Recorder to make the recordings and then save them in
MP3 format. You can then copy the recordings into iTunes and onto your iPod, and you
can burn selected recordings onto CD-ROM or audio CD.

3.7 Video editing software

Pre-recorded video on a camcorder these can be uploaded to the computer by
means of a cable connecting the camcorder to the firewire port (firewire socket) on the
computer. A firewire is in essence a device that allows you to transfer video
recordings very quickly from your camcorder to your computer. Many modern computers
already have a firewire port built in. If your computer does not have a firewire port then
you have to buy a firewire card and slot it in - and here you need a bit of technical
knowledge. Most modern computers systems that are designed for audio and video
applications have firewire ports built into them. If you are not sure that you have a firewire
port, have a look at the sockets for connecting to externaldevices on your computer.
A firewire port is smaller than a USB port, but it will probably be located near the USB

port(s).

c >
B t::,-L’/

! y

r 4

Firewire cable USB cable

Firewire port Firewire port (left)
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There is a good range of products offered by Hauppauge for the efficient digitisation of
video materials from a variety of sources http://www.hauppauge.com

Adobe Premiere: http://www.adobe.com

Ulead VideoStudio: http://www.ulead.com

Pinnacle Studio: http://www.pinnaclesys.com

Final Cut Pro (Mac): http://www.apple.com/finalcutpro

Matrox offer a wide range of products: http://www.matrox.com
o Movie Maker is bundled with Windows.

NCH Software offers a wide range of packages:
http //www.nchsoftware.com

VideoSpin by Pinnacle: A free video editing package:
http://www.videospin.com/Redesign/

3.8 Software Format

- ASF: Advanced Streaming Format. This is a Microsoft's own file format that stores
both audio and video information and is specially designed to run over the Internet.
ASF enables content to be delivered as a continuous stream of data (streaming audio
or streaming video) with little wait time before playback begins. This means that you no
longer have to wait for your audio and video files to fully download before starting to
view them. Cf. the WMV format (below).

«AVI: Audio Video Interleave format. Still very popular, but giving way to MPEG,
which takes up less storage space.

- FLV: Abbreviation for Flash Video, a proprietary file format

used to deliver video over the Web using the Adobe Flash

Player plug-in.

«MOV: The standard format for storing video files on the Apple Macintosh to be
played in the QuickTime media player - which is also available for the multimedia

PC. Economical in terms of storage space. http://www.apple.com/quicktime

«MPG or MPEG: Motion Picture Expert Group. Probably the

commonest format for storing video, especially on the Web. Economical in terms of
storage space.

-MP4 AVC: Abbreviation for MPEG-4 Advanced Video Coding. The MP4
AVC file format is used to store video files in a more manageable size wihout affecting
the quality. It is also increasingly being used for storing video on iPods and similar portable
devices. See also MPEG-4 Advanced Audio Encoding.

-RM (RealPlayer): Used for playing streaming audio and

streaming video. RM enables content to be delivered as a continuous flow of
data with little wait time before playback begins. This means that you do not have to
wait for your audio and video files to fully download before starting to view them:
http://uk.real.com/realplayer/. RealPlayer enables you to download streaming files (e.g.
YouTube videos) from the Web.

« WMV: Windows Media File. This is Microsoft's own file format.

WMV is the same as ASF (see above) except that it can be downloaded instead

of streamed from a server located at a distance.
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3.9 Plug-ins
A plug-in is an extra piece of software that a Web browser needs to run certain elements
of a Web page, e.g. animated sequences and audio or video clips. You will find that
when you click on an icon that signifies the availability of streaming audio or video
material, your browser will link with a plug-in. If the plug-in is not already installed
on your computer then you will be able to download it free of charge. Web pages
incorporating multimedia often need plug-ins such as Flash Player, QuickTime,
Shockwave Player or RealPlayer. Plug-ins are usually quick and easy to install,
normally free of charge and open up a wealth of new material. Sites that require a
plug-in usually provide a link to a site from which the essential plug-in can be
downloaded. These are the sites from which Flash Player, Shockwave and RealPlayer can
be downloaded:
. Flash Player: http://www.adobe.com/products/flashplayer/

QuickTime: http://www.apple.com/quicktime

RealPlayer: http://uk.real.com/realplayer/

Shockwave Player: http://www.adobe.com/products/shockwaveplayer

3.10 Podcasting

A podcast is a broadcast digital audio recording, usually in MP3 format, made available
via the Web in a way that allows the recording to be downloaded automatically for
listening at the user's convenience. The term vodcast is used to describe a broadcast
digital video recording, usually in MPG format, also made available via the Web.
The term podcast takes its name from a combination of iPod (Apple's portable
digital media player) and broadcasting, but podcasts and vodcasts do not necessarily
require the use of an iPod or similar device. Podcasts and vodcasts can simply be
downloaded to a computer and played using a standard media player program.

3.11 Saving and converting streaming media for use offline

It is possible to save streaming audio or streaming video clips to your hard disk so
that they can be used offline. RealPlayer enables you to play and save video clips
from popular websites such as YouTube and Metacafe (http://www.metacafe.com),
record live streams, and play awide range of popular audio and video formats.
There are many software tools available that enable you to capture streaming media and
convert it from one form into another, e.g.

-ConvertTube: An online service for converting YouTube video clips to a variety of
other formats: http://www.converttube.com

- DVDVideoSoft: Offers a range of different converters:
http://www.dvdvideosoft.com

- FlashLynx: http://www.nchsoftware.com/streamvcr/index.html

- HiDownload: http://www.hidownload.com

How to Capture Streaming Media: http://www.stream- capture.com

- Keepvid: http://keepvid.com

- Orbit: http://www.orbitdownloader.com

« Net Transport: http://www.xi-soft.com

Replay Converter: A tool for converting audio and video files
http://applian.com/replay-converter
« YouConvertlt: Free online media conversion.

http://www.youconvertit.com
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- YouTube Tutorials: See these tutorials on embedding YouTube video clips
into PowerPoint: http://www.youtube.com/watch?v=Zwqyg5uNCIlY
http://www.youtube.com/watch?v=hChg5drjQl4
-Zamzar: Free online file conversion. Convert images, audio files, video files and
document files from one format to another without having to download software.
http://www.zamzar.com

3.12 Audacity

Audacity is a free, easy-to-use audio editor and recorder for Windows, Mac OS X,
and GNU/Linux. You can use Audacity to Record live audio; Cut, Copy and Paste,
Delete, Duplicate, and Split audio files; Change the speed, pitch or volume of a
recording; Apply effects to any part of the sound; and Align audio segments.

Audacity is a popular Open Source tool for creating and editing podcasts; it is
freely available to download, install and modify, and is relatively easy to use. You can
download a copy of Audacity for Mac, Linux, or Windows from
http://audacity.sourceforge.net/. For an overview of downloading and installing
Audacity including the LAME MP3 encoder, see:http://www.youtube.com/

a. Download and Install Audacity from
http://audacity.sourceforge.net/
b. Read through the Audacity tutorial in

www.wikieducator.org/Using_Audacity/
: Load Audacity and record audio into Audacity using a microphone.
: Import audio files into the Track Window from your computers hard-drive.
: Edit audio files by selecting, cutting, pasting, silencing, and deleting track,
oom-in, fade-out, fade-in etc.
Name, sort and label tracks.
. Compress an audio file.

c
d
e
z
f
g9
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1.0 INTRODUCTION

Text plays vital role in multimedia delivery and is composed of combinations signs or
symbols that are used in writing or printing and which represent a speech
sound. Texts are used in effective communication of ideas, thoughts, plans, feelings
and emotions precisely and without any loss of form. Text mode refers to
alphanumeric or character operation mode which computer uses in displaying letters,
numbers and other text characters. In actual fact, texts are numeric codes stored in
computer systems.

Succinctly, text suitability is an important consideration when designing multimedia
applications. This is due to the fact that text has some form of graphical element in its
texture and like all graphics; it must appeals to the eyes without leaving sour taste in the
mouth of the reader. The choice of appropriate text attributes to be used in
multimedia applications must be based on the nature of the audience (formal,
informal, children, adult etc) and the essence of the multimedia presentations (education,
business, news, information or entertainment etc).

In this unit, we shall study a subject called Typography. Typography deals with the
appearance of text in multimedia presentations, its attributes and design
considerations.

3.0 CHARACTER SETS

The visual appearance of a text come in variety of forms without altering the
information it conveys. Basically, alphabets, digits, punctuations and other symbols forms
the simple character set called abstract characters of a text. Abstract characters in a
particular language are grouped into alphabets. E.g. the alphabet of English contains
the upper case letters A to Z, the lower case letters a to z, the digits and a number of
punctuations.

Digital representation of text involves defining a mapping (called character set)
between the abstract characters and the values (called code points) that are stored in a
computer system. The domain (abstract characters) of this mapping is called character
repertoire.

3.1 Digitization of Text

Text is the common and most acceptable communication means among many computer
systems which are heterogeneous in nature. A common character set is therefore desirable
and essential. The American Standard Code for Information Interchange (ASCII) character
set has been extensively adopted across many computing platforms to code plain text in
binary forms.

ASCII has a 7-bit code range which infers that the code points can be store in 7 bits,
and 127 codeable characters. Its domain only comprises

95 printable characters (A-Z, a-z, 0-9,!, @, 2, ", & *, (,), +, = I, \, |, ;,

oo, # 8, %, etc). The values 0 to 31 and 127 are assigned to control characters.

In 19 ISO 646 adopted ASCII as its standard and later came out with an improved

standard ISO 8859 with 8-bit characters to address the inadequacy of the 7-bit ASCII

character set. However, ISO 8859 have limited code points available due to its 8-bit

nature and having 7-bits ASCII identical characters in all its parts. To address this
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shortcoming, ISO produced another standard called ISO/IEC 10646-1: Universal

Multi-Octet Coded Character Set in 1993. ISO/IEC 10646-1 uses four hierarchical
bytes (group (g), plane (p), row (r), column (c)) to encode a character, and can therefore
have at most 232 code points.

Another standard is The Unicode Standard, Versionl1.0 in 1991 (version 3.0 came out in
year 2000). The Unicode character system uses 2 bytes (16-bit character set) to encode
each character. Unicode 32-bits system is now available in some computing
platforms. Unicode attempts to specify a character set to embrace all languages of
the world. The Unicode transmission format 8 (UTF-8) protocols provides for
support of extended ASCII characters and translation of Unicode. A UTF-8 enables
a far greater range of names than can be achieved using ASCII or extended ASCII
encoding for character data.

3.2 Text Attributes
Text can be created and presented in most appealing ways using combinations of the
following attributes.

3.2.1 Font Type

Each character may be represented in different sizes, shapes, and shades, and a character’
visual representation is refer to as font face or typeface. A font face is a family of
graphic characters with a coherent design, similar look and feel while a font is a set of
graphic characters with a specific design in a specific size and style. Here are some
of the common families: Times, Helvetica, Courier, Garamond, and Universe. Some
examples of the available font face are shown in figure 3.1 below.

Arial Arial Black Arial Rounded MT Bold

Bookman Old Style Copperplate gothic bold Elephant Franklin
Gothic Medium Cond Imprint MT Shadow Tahoma Times New Roman

igure 3.1 Sample Font Types

In some other terms weight which is a measures of characters’ darkness, or the
thickness of the strokes is used. The names used to distinguish weight are not
uniform between type suppliers. The commonly used names are: ultra light, extra
light, light, semi light, medium, semi bold, bold, extra bold, etc.

3.2.2 Font Style
Font style or shape refers to the different appearance within a family. Example
include regular or normal (upright), bold, sloped (oblique), italic, SMALL CAP

Font Style  Normal style FONt Style  Bold style FONt Style Italic
Style FONT STYLE ~ Small CAP Style

Figure 3.2  Sample Font Styles
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3.2.3 Font Size

When putting characters on to a page, we need to know some basic measurement of the
types we use. Each character has a bounding box. This is the rectangle enclosing the
entire character. Each character has an origin. It is usually place on the baseline. The
width of the character determine where the origin of the next character will be. The
distance between the origin and the left side of the bounding box is called left side
bearing.

bounding
box ________

next
character
.. character
oTigin -
origin
—— - .
left cide
beating

character width

Figure 3.3 Font measurement

(Source: COMP3600/SCI2600 Multimedia Systems, Department of

Computer Science, Hong Kong Baptist University)

As we all know, some of the lower case letters extend upward, like b and h, while
others extend downward, like g, p and g. The height of the lower case letter without
ascender and descender is called the xheight. The height of the upper case letters is
called the cap-height.

Ascender
i
=] AXohpmn
x-height H[:uetpl:f:nv:!f.fr

Figure 3.4 Font Size
(Source: COMP3600/SCI2600 Multimedia Systems, Department of Computer
Science, Hong Kong Baptist University)

Font size can be measure using any of the following two measurement criteria: point and
pixel. The point measurement criterion uses dot per inch (dpi) which is the standard
used in measuring computer monitor and printer resolution. It is expressed as the
number of dots that a device can display or print per linear inch and the greater the
number of dots per inch, the better the resolution.
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A picture element (pixel) is the smallest element that computer screen, printer and
software can manipulate to create letters, numbers, or graphics. The pixel measure one
spot in a rectilinear grid of thousands of such spots that form an image produced on the
screen by a computer or on paper by a printer. The resolution of the computer
monitor is measured in term of pixels per inch (ppi) of monitor display and
determines the amount of information that appears on the computer monitor.. A monitor
setting of 1280 x 1024 has 1.3 million dpi while

800 x 600 monitor setting has 480,000 dpi. On a Macintosh monitor, the standard
resolution is 72 dpi while on a Windows monitor, the standard

resolution is 96 dpi. Low resolution, such as 640 x 480, makes items on the screen
appear large, although the screen area is small. High resolution, such as 1024 x
768, makes the overall screen area large, although individual items appear small

Comparison table of points and pixels on
windows computer

Points |Pixels Points Pixels
6ot 80X 1Ant 22ny
7pt Opx 17pt  [23px
7.5pt  [10px 18pt  [24px
8pt 11px 20pt  [26pX
Opt 12px 22pt  29px
10pt 13px 24pt  [32pX
10.5pt  [14px 26pt  35px
11pt 15px 27pt  [36pX
12pt  [16pX 28pt  [37px
13pt  [17px 29pt  [38px
13.5pt  [18px 30pt  |40px
14pt 19px 32pt  42px
14.5pt  20px 34pt  45px
15pt  [21px 36pt  |48px

Table 1: Font Size: Points vs. Pixels

(Source: L. Reid & V. Tryphonopoulos (2009). Computer Science CS1033:
Multimedia and Communication, www.csd.uwo.ca/courses/CS1033)

Font Width: the amount of expansion or contraction with respect to the normal or
medium in the family.
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Size: 1 inch = 72.27 point in printing industry and 1 inch = 72 point in
PostScript systems.

Font Size 8points Font Size
points Font Size 10 points Font Size
11 points Font Size 12 points
Font Size 14 points Font
Size 16 points Font Size
18 points Font Size 20 points Font Size

P2 points Font Size 24 points Font
Size 26 points

~ont Size 28 points Font Size
36 points Font Size 48

noints FONt 72
poInts

Figure 3.5 Different Font Sizes

3.2.4 Font Colour

Colours add some flavour to the general appearance and visual appeals of texts when
used in the right manner and context. Over time, colours have been used to describe
interesting and exciting personal, group, event, or location’s details or qualities.
Colours have a way somehow of reflecting our characters, attitudes, beliefs and opinions.
There are some guidelines (colour scheme) concerning the appropriate choice and use of
colours when working with texts. The colour scheme is a combination of colours (primary
and secondary) choosen to add esthetics’ values to the document while ensuring the
content is preserved.
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Primary colour is one of three colours, red, yellow and blue which can mix together
to obtain secondary colours. The multidimensional color space consisting of the cyan,
magenta, yellow, and black intensities that make up a given color. Commercial color
printing devices generally use this system of four-color process inks on hardcopies
(papers) while the three-colour (red, green and blue) process is usually used on monitors,
scanners, digital cameras, and computer printers. The following colour properties are
worth considering when choosing colours for texts and background.

Properties of Color

«Colour management: The process of producing accurate, consistent color
among a variety of input and output devices. A color management system (CMS)
maps colors between devices such as scanners, monitors, and printers; transforms
colors from one color space to another (for example, RGB to CMYK); and provides
accurate on-screen or print previews.

« Colour profile: A profile contains the data needed for translating

the values of a color gamut. This data includes information about color, hue, saturation,
and brightness.

«Hue: The "colour"of the color (or the wavelength of light) is the position of a color
along the color spectrum. For example, green is between yellow and blue.

« Saturation: The intensity of the color, the purity of a color's hue

moving from gray to the pure color.

+Brightness/VValue: This is the relative lightness or darkness of the color

« Colour space: A set of three values that defines how a color can

be represented on computer devices such as monitors, scanners, and printers. For
example, in the LAB color space, the terms luminance or whiteness (L), redness-
greenness (A), and yellowness-blueness (B) are used; in the HVC system, the terms
are hue (H), value (V), and chroma (C). Color space refers to the three-dimensional space
that is defined by the respective values, such as L, A, and B.

« Running the gamut: The gamut is the particular range of colors that a device is
able to produce. A device such as a scanner, monitor, or printer can produce a
unique colour spectrum, which is determined by the characteristics of the device
itself. The relative saturation of colors is maintained from gamut to gamut. Colors outside
the gamut are changed to colors of the same saturation, but different degrees of brightness
at the edge of the gamut.

«Colour depth: The number of colors per pixel the monitor and graphics adapter
support.

Font Colour Red

Font Colour Green

Font Colour Blue Font Colour Magenta
Font Colour Black

Figure 3.6 Different Font Colours
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3.2.5 Special Effects
The examples below are some special effects that can be apply to texts within a multimedia
presentation for emphasis, clarity, visual appeal reasons.

Underline UNDERLINED FONT Strikethrough STRIKETHROUGH
FONFeqg N -

Double Strikethrough e.g.N

Shadow SHADOW FONT Superscript SUPER3“RPT FONT
Subscript SUBgcripr FONT Outline

Emboss

Engrave

3.2.6 Font Layout

3.26.1 Kerning

Kerning is the extra adjustment between two specific characters and specifies the distance
between adjacent individual letters and the measurement is expressed in ‘“em” (negative,
0, positive values). Normally, characters are placed one next to the other, i.e., the distance
between the origins of the adjacent characters is equal to the character width. But due to the
shape of the characters, the space between certain characters may look uneven, e.g., the A
and v in the figure. Therefore, we need to kern the characters

KERNING Normal with no kerning
ERNING Expanded spacing with 1pt kerning

KERNING Condensed spacing with 1pt keming

KERNING Normal spacing with 1.5pts kerning KERNING
Normal spacing with 2pts kerningKERNING Normal s
pacing with 4pts

kerning

Figure 3.8 Characters Spacing with Kerning

3.2.7 Classification of Font face

Generally font faces can be classified as either serif or sans serif. Serif is the little flag or
decoration at the end of a stroke. On printed pages, serif fonts are used for body text while
sans serif fonts are used for headline because the serifs help guide the reader’s eye along the
line of text. Multimedia presentations are displayed on low resolution screen where sans
serif fonts will be far more legible.
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E E

J

.

Sant Sare Sef
«EScrif =Cano Corif
oTalls «No tails
oScript «Block-oriented
«Body paragraphs eHeadings, titles
eTimes Roman, Cour ter New, eArial, Verdana, Helvetica,
Century Schoolbook, Palatino Arial Black, Comic Sans MS

Figure 3.7 Font Faces
(Source: L. Reid & V. Tryphonopoulos (2009 ). Computer Science
CS1033: Multimedia and Communication, www.csd.uwo.ca/courses/CS1033)

3.2.8 Font Formats

Font formats can be divided into two main categories: bitmap fonts and
outline fonts.

Bitmap fonts come in specific sizes and resolutions. Because the font contain the
bitmaps of the character shapes. The result will be very poor if they are scaled to
different sizes. Outline fonts contain the outline of the characters. They can be scaled to
a large range of different sizes and still have reasonable look. They need a rasterizing
process to display on screen. Nowadays, outline fonts are much more common than
bitmap fonts. There are two kinds of outline fonts: PostScript and TrueType.

All version of Windows support TrueType fonts. Windows3.1 and Windows95 require
Adobe Type Manager (ATM) to display PostScript fonts. PostScript printers have a
number of resident PostScript fonts.

3.3  Criteria for Choosing Text in multimedia

Choosing the combination of fonts to use in a multimedia presentation does not come
quite easy and cheap. It requires careful planning and consideration of some text
design criteria which may enhance the esthetics of the presentation and thus makes it
more exciting, appealing and stimulating for the audience to watch, view or listen to. We
outline some of these criteria as follows:

3.35 Readability and Legibility

Legibility which means that fonts must be written or printed clearly for easy reading is
a basic requirement when designing multimedia presentations. The font face, its shape
and sizes must be appropriate to allow for easy reading by the intended audience.
In most cases for instance, adult audience require large font size while young or children
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would make do with small font size. Here are some tips:

a. Use right contrasting and avoid dark text against dark background;

b. For small type, use the most legible font available, decorative fonts are useless;

c. Use as few different faces as possible in the same work, but vary

the weight and the size and using italic or bold styles;

d. Vary the size of a font in proportion to the importance of the message;

e. Never underline a text in a webpage;

f.In large size headline, do proper kerning so that the spacing feels right; and

g. Use maximum of between 2 and 3 different font faces in a multimedia
presentation.

3.3.6 Visual Appeal
Use the following tips to ensure that the fonts chosen make visual appeal to the audience
eyes:

a. Make sure that both the font and graphic complement each other;

b. Choose font that coordinates with the graphics being used;

C. Explore the effects of different colours and of placing the text on various
backgrounds;

d. Carefully position the font to achieve good balance with the other multimedia
elements;

e. Avoid using exotic fonts in other to ensure font consistency on different
computing platforms; and

f. Use maximum of 2 to 3 colours in a multimedia document or

website.

3.3.7 Text Layout

The layout is very important when developing multimedia presentations. It provides
detailed overview of how the document would look like after it must have been
prepared. Font and other multimedia elements should be spread over the multimedia
presentations to ensure readability and visual appealing. Thus the chosen font must be
simple, clear and must make use of white spaces between characters, words and
lines appropriately. In text block, adjust the leading for the most pleasing line spacing.
Lines too tightly packed are difficult to read.

3.3.8 Mood Creation

a. Set the mood using appropriate font attributes and text layout;
and

b. Use San Serif for headings and Serif for body. Sans Serif
headings create better visual appeal while Serif body looks better.

3.4  Cross platform issues

When you build your multimedia project on Windows platform, and play it back on
a Macintosh platform, there will be some differences. Fonts are perhaps the greatest
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cross-platform concern. If a specified font does not exist in the target machine, a substitute

must be provided. Some cross-platform  applications, e.g., Director, allow the
developer to specify the mapping of fonts.

Different encodings on different platform is also a big problem. Special characters may
need to be converted to bitmaps in order to be display correctly on different platforms.

Different systems and font manufacturers encode different symbols in the extended
character set.
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UNIT 2 GRAPHICS, PICTURES AND IMAGES
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1.0

Graphic is concerned with drawing, printing or designing pictorial illustration of places,
events, people etc. and gives a vivid description of what it is being represented. Graphics
refers to drawings or images that represent objects or fact in computer software.
is a digital representation of images and non-text information (i.e drawing, chart,

table, and photograph). Graphics are used to illustrate certain concepts more clearly

CMYK Colour Code

HSB Colour Code

YUV Colour Model

Gamut

Colour Palette

Dithering and Aliasing
Dithering

Anti-aliasing

Image and Graphics File Formats
Compression Algorithms
Conclusion

Summary

Tutor-Marked Assignment
References/Further Reading

INTRODUCTION

than text can.

Graphics play an important role in teaching since many people are visual learners — think

about car icons or road signs. There is no movement or
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animation in a graphic and as navigation aids in many software packages.

3.0 The Nature of Digital Images

An image is a spatial representation of an object, a two-dimensional or three-dimensional
scene or another image. Often the images reflect the intensity of lights. Most
photographs are called continuous-tone images because the method used to develop the
photograph creates the illusion of perfect continuous tone throughout the image. Images
stored and processed by computers, displayed on computer screens, are called digital
images although they often look like continuous-tone. This is because they are
represented by a matrix of numeric values each represents a quantized intensity values.

3.1 Basic Concepts

3.1.1 Pixel (Bitmap)

A digital image is represented by a grid (array, matrix) of squared picture element
known as a pixel. The pixel reveals the minutest details in a digital image. Each pixel is
a numerical value corresponding to a graphical object. A 640-by-480 screen is capable
of displaying 640 distinct dots on each of its 480 (rows) lines, or about 300,000 pixels.
A

800-by-600 screen is capable of displaying 480,000 pixels.

3.1.2 Digitization

Digitization refers to the process of translating a piece of information (text, images,
sound recording, or video) into binary digits (BITS).

A bit is an electrical pulse or signal that represents the state at which it can be in a
given moment of time. Usually, electrical pulse is either in “ON” or “OFF” state at
any given time. In the computer, these pulses are represented in the binary digital form
of “1” and “0” for “ON” state and “OFF” state respectively. Words and images are
represented in bits or bytes where a byte is a collection of 8bits (i.e. 0000 0000). So
with 8 bits there are: (28)= 256 possible combinations of Os and 1s.

Binary Power of 2 Decimal |Hexadecimal
1 2 to the power of 0 |1 1

10 2 to the power of 1 2 2

100 2 to the power of 2 4 4

1000 2 to the power of 3 |8 8

10000 2 to the power of 4 |16 10

100000 2 to the power of 5 32 20

1000000 2 to the power of 6 |64 40

10000000 2 to the power of 7 128 80
100000000 2 to the power of 8 256 100
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Binary Decimal  |Hexadecimal
0000 0000 0000
0001 0001 0001
0010 0002 0002
0011 0003 0003
0100 0004 0004
0101 0005 0005
0110 0006 0006
0111 0007 0007
1000 0008 0008
1001 0009 0009
1010 0010 000A
1011 0011 000B
1100 0012 000C
1101 0013 000D
1110 0014 0000E
1111 0015 000F

3.1.3 Depth

The depth of an image is measured in the number of bits used to represent each
pixel.

. 1-bit black-and-white image (with no gray), also called bitmap image.
nValue O = Black |
sValue 1 = White

. 4-bit can represent 16 colours, used in low resolution screens(EGA/VGA)

mValue 00 = Black
nValue 01 = Grey q:.j
mValue 10 =Light Grey W __ L
sValue 11 = White

= 4 bits > 2% S 16 grey shades

18 s (0000, 0001,0010, 0100, 1000 etc.
A 012 14 15
. 8-bit can have 256 colours. The 256 colour images are often known as

indexed colour images. The values are actually indexes to a table of many more
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different colours. For example, Colour 3 is mapped to (200, 10, 10).

0 | 255,00
1 | 55,010
| 2 (200, 0, 0)
S = 3 | (20000100
53 (10,10, 10)
24| 20 I
55 (0,100, 100)
. 8-bit grey 256 grey-levels. The image contains only brightness/intensity

data without colour information.

e8 bits > 28 - 256 gray levels (shades)

(Source: L.Reid & V. A normal greyscale image has a bit
color depth of 256 grey levels

Tryphonopoulos (2009 ). Computer Science CS1033: Multimedia and
Communication, www.csd.uwo.ca/courses/CS1033)

*16-bit can have 65536 colours, also known as hi-colour in Windows systems. The
16 bits are divided into 5 bits for RED, 6 bits for GREEN and 5 bits for BLUE.

*24-bit 224 = 16,777,216 colours, true colour. Each byte is used to represent the intensity
of a primary colour, RED, GREEN and BLUE. Each colour can have 256 different
levels.

COLOUR RED |GREE BLUE
N

Red 255 0 0
Green 0 255 0
Blue 0 0 255
Yellow 255 255 0
Magenta 255 0 255
Cyan 0 255 255
Light gray 127 127 127
White 255 255 255
Black 0 0 0

*32-bit 232 = 4,294,967,296 (4G). Usually, 3 bytes are used to represent the three
primary colours and the fourth byte is used as the alpha channel.

3.1.4 Resolution
Resolution measures how much detail an image can have as previously mentioned in
Module 3 Unit 1 Section 3.2.3. There are several resolutions relating to images;

some of which are the followings:

a. Image resolution is the number of pixels in an image. 193 x 145
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= 27,985 pixels, 3088 x 2320 = 7,1641,60 pixels.
b.Display (Monitor) resolution — refers to number of dots per inch (dpi) on a monitor.
Windows  systems usually have  96dpi resolution. Some high resolution video
adapters/monitors support
120dpi. For example, a 288 x 216 image displayed on a monitor with 96dpi will be 3” x 2
Y,
C. Output resolution — refers to number of dots per inch (dpi) on a
(hard copy) output device. Many printers have 300dpi or 600 dpi

resolution. High-quality image setters can print at a range between 1200dpi and
2400dpi, or higher.

Sources of Digital Images

There are many sources from which digital images may be acquired or created. Notably
among them are:

a. Draw/Paint Programs

Make an image from scratch with a paint program. A good program will allow you to
choose the depth, resolution and size.

b. Clip Art Packages

Grab an image of a screen. The depth, resolution and size is determined by the screen.

C. Digital Cameras and Camcorder

Capture an image from a digital camera or a camcorder. The depth, resolution and size are

determined by the camera or the camcorder. The popular depth is 24-bit. The commonly
used resolution is 320 x 240, 640 x 480 and 800 x 600.

d. Scanners and Digitizers
. Scan or print a photograph using a scanner. You can select from a range of

different depths and resolution. The choice should be determined by the type of original and
the final output form.

. Convert from existing digital media— e.g, photoCD. The attribute is
determined by the original image.
e. Synthesize an image from numerical data i.e. using MATLAB Software.

f. Stock photograph agencies

Vector Graphics
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In mathematical and scientific applications, images are seen as vector objects or
graphics. They are thus represented by such attributes as size, colour, spatial location,
dimension etc rather than pixels. This is an abstract representation of a 2-dimensional
or 3-dimensional scene. A vector graphics file contains graphics primitives, for
example, rectangles, circles, lines. There are many languages for describing vector
graphics; some of which are:

a. PostScript was developed by Adobe as a page description language.

b. Virtual Reality Markup Language (VRML) use for describing a scene in a virtual
world.

c. Scalable Vector Graphic (SVG) user for describing two-

dimensional graphics in XML. It allows three types of graphic objects: vector graphic
shapes, images and text.

3.3 Comparison of Bitmap Graphics against Vector
Graphics

Comparison  [Bitmap Vector graphic

Factor

1. |Processing |A bitmap image is easier |Displaying a vector graphic
to render. usually involves a large

amount of processing.

2. |Attributes |JA bitmap contains an |A vector graphic contains
exact pixel-by-pixelmathematical description of
value of an imagelobjects. Vectors are bound
Bitmaps are bound to theto mathematical formulas
individual  pixels  thatthat describe them.
describe them.
3. |Resolution |A bitmap file is fixed in |A  vector graphic is
resolution. Changing sizeresolution independent,
means losing informationChanging size does not
and they tend to fall apartreally affect them and they
when you make themtend not to be as detailed as

bigger. bitmaps.
4. Memory The file size of a bitmap igThe file size of a vector
Usage completely determined  [graphic depends on the
by the image resolution jnumber of graphic elementg
and its depth. it contains. They are

smaller in file size.

3.4 Colour Coding Systems

The choice of appropriate colour combination to use in multimedia presentations can be
cloudy and cumbersome at times. This is due to the fact that careful choice of colour
involves technical and subjective competencies. We need to understand the technical
compositions of colour and how it is perceived by human beings.

Colour is the frequency or wave-length of a light wave within the narrow band of
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the electromagnetic spectrum (380 — 760nm) to which the human eye responds. Its

perception is human physiological activities which thus involve choosing a right colour
or colour combination on trial basis, and on aesthetic judgment. In true colour,
each pixel represents some color shades.

3.4.1 RGB Colour Code

The RGB colour code is the most widely colour model used in computer graphics and
websites. RGB is an additive coding system in which varying amount of the three
primary colours (Red, Green and Blue) are added to black to produce new colours.
limagine three light sources of the primary colours shining on a black surface.
Different secondary colours can be produce by varying the intensity of the lights on the
black surface as illustrated in the diagram below.

Red

agenta

Yellow
White

Blue
Green

Cyan
Figure .... RGB Colour Coding System

RGB code can be expressed in decimal (binary interpretation) and Hexadecimal codes. A
pixel in RGB is represented by three decimal values <red, green, blue>, where each
value ranges from 0 to 255 and therefore provide 256 different color shades. For
example Red has avalue of <255, 0, 0>, Green <0, 255, 0> and Blue <0, 0, 255>.
Combination of the varying values produces different color e.g <0, 255,

255> give Turquoise, <255,255,255> gives White, <255, 0, 255 > gives Pink etc. A given
colour is therefore certain mixture of red, green and blue.

The hexadecimal representation is based on the hexadecimal numbering system which
comprises of numbers (0, 1, 2, 3,4, 5,6, 7,8,9, A B, C,D, E, and F). Each RGB colour
can be uniquely represented by 6digits hexadecimal number preceded by “#”. E.g.
#00AEED Light Blue. There are sixteen predefined hexadecimal numbers in the RGB
spectrum as illustrated in the figure below:
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Black (#000000)  Silver (#COCOCO)  Gray (#808080) White (#FFFFFF)

Maroon (#800000)

Green (#008000) Lime (#00FF00) Olive (#808000) Yellow (#FFFFO0O0)

Navy (#0000128) Blue (#0000FF) Teal (#008080) Agua (#00FFFF)

Red (#FF0000) Purple (#800080) Fuchsia (#FFO0FF)

Figure. Predefined Hexadecimal Colours

3.4.1.1 Conversion from Hexadecimal to Decimal

The RGB decimal code (i.e. <255, 0, 0> for Red) is a 3-byte binary number which
means <11111111, 00000000, 00000000>.

To convert this number to its hexadecimal equivalent, simply divide each binary
number into two 4-bits number, e.g. <1111 | 1111, 0000 |

0000, 0000 | 0000> and then convert each 4-bits number to its decimal equivalent, and
then finally to its hexadecimal equivalent. In this instance,

<255, 0, 0> Given Decimal
Color Code

<11111111, 00000000, 00000000> Step 1.
<1111 | 1111, 0000 | 0000, 0000 | 0000> Step 2.
<15 | 15, 0 | O, 0o | 0> Step3.
#FF0000 Desired

Hexadecimal Code

Can you try these: #B7B7B7 = <183, 183, 183>?
#0469B3 =<4, 103,179>?
#4A2885 = <74, 40, 133>?
To convert from hexadecimal to decimal, follow the outline steps above in reverse order.
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3.4.2 CMYK Colour Code

The CMYK code uses three primary colour pigments, cyan, magenta and yellow and
is based on the light absorbing quality of inks printed on paper. CMYK is a subtractive
model. The value of each primary colour is assigned a percentage from the lightest (0%)
to the darkest (100%). Because all inks contain some impurities, three inks actually produce
a muddy brown and a black colour is added in printing process as a result of
combination of the three colours.

Black

Green

Yellow

Red

Figure The CMYK Colour Code
Some secondary colours from the CMYK as shown in the diagram above include:
a. Purple = Cyan + Magenta b. Green = Cyan + Yellow

C. Red = Magenta + Yellow
d. Black = Cyan + Magenta + Yellow

3.4.3 HSB Colour Code

The HSB colour code is based on the human perception of colour and has three
fundamental characteristics.

i.  Hue

Hue is the wavelength of the light and Hue is often identified by the name of the
colour it represents. Hue is measured as a location on the standard colour wheel as a degree
between 0° to 360° .
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ii. Saturation

Saturation is the strength or purity of a given colour. It represents the amount of gray in
proportion to the hue and is measured as a percentage from 0%(gray) to 100%(fully
saturated).

iii. Brightness
Brightness is the relative lightness or darkness of a given colour. It is measured as a
percentage from 0%(black) to 100%(white).

3.4.4 YUV Colour Model

The YUV color code is widely used in encoding colour for use in television and
video. The theory behind this model is that human perception is more sensitive to
brightness than any chrominance information, so a more suitable coding distinguishes
between luminance and chrominance. This also produces a system that is compatible
with black-and-white TV systems.

The Y-signal encodes the brightness information which is used by the black-and-white
television system while the U and V channels encode the chromatic information. The
resolution of the U and V channels is often less than the Y channel for the reason of
reducing the size.

3.5 Gamut

The gamut of a colour code is the range of colours that can be displayed on computer
monitors or printed on papers. The colour spectrum that can be viewed by human eye is
wider than any method of reproducing colour. Different colour models have different
gamut. The RGB code has a larger gamut than that of the CMYK code.

“sible
Color Gamut

RGB
Color Gamut

Pantone
Color Gamut

ChMYK
Color Gamut

Figure ..... Colour Gamut
Source: Arts 21- Introduction to Computer for Art
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3.6 Colour Palette

A colour palette is an indexed table of available colours spectrum in a given colour
code. When working in 8-bit mode, a system can display only 256 colours out of a
total of 16 million colours (<256, 256, 256>). The system keeps a default palette of
available colours.

One major challenge in multimedia presentations is refer to palette flashing. Palette
flashing is an unpleasant flash of unwanted colours that occurs on the computer monitor
when working with digital images. It occurs because each graphic application has its
own colour palette and may replace the computer monitor’s palette with its own for the
period it is active.

3.7 Dithering and Aliasing

3.7.1 Dithering

Dithering is a technique to increase the number of colours to be perceived in an
image. It is based on human eye’s capability for spatial integration (i.e. if you look at a
number of closely placed small objects from a distance, they will look like
merged together). Dithering technique groups a number of pixels together to form a
cluster. When viewed from sufficient distance, the individual pixel will not be
distiguishable. The cluster will look like a single block of a colour different from the
individual pixel.

Figure Dithering
(Source: COMP3600/SCI2600 Multimedia Systems, Department of
Computer Science, Hong Kong Baptist University)

3.7.2 Anti-aliasing

Aliasing is what happens when solid colors don't conform to vertical and horizontal edges.
It is caused by the limited resolution of an output device that makes edges seen as
staircases.

Anti-aliasing is a technique to soften the staircase effect of aliasing through color

interpolation. It works by filling in pixels which should be half filled with different levels
of gray or matching colours. The result is sharper edges, not blurring or smoothing them.
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Aliased Anti-aliased

Figure ..... Colour Gamut
Source: Arts 21- Introduction to Computer for Art

3.8 Image and Graphics File Formats

A digital image stored in a computer file must conform to specific standard or
format. In addition to the pixel data, the file contains some information (such as the file
format, image size, image depth, colour palette and compression technique) to identify
and decode the data.

Some formats are defined to work only in certain platform while other can be used
for all platforms. Some formats are specific for an application. Some formats are
for images, others are for vector graphics. Some formats allow compression, others contain
only raw data.

Image Formats With Web Browser Support
GIF: Graphics Interchange Format
JPEG: Joint Photographic Experts Group
PNG: Portable Network Graphics

Image Format Attributes

GIF87a | GIF89a | JPEG Progressive
JPEG PNG

Lossless X X - - X
Compression
Transparent | - X - - X
Backgrounds
Interlacing X X - X X
Animation - X - - -
Maximum 256 256 16.7MILL | 16.7MILL |16.7MILL
colours

3.9 Compression Algorithms

Compression algorithms can reduce file size by about an order of magnitude.
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Lossy schemes Lossless schemes

Discard pixel information Do not discard pixel information
(Very high compression rates)
Reconstruction by approximation Reconstruction by  calculation

(exact)
Range of quality / compression |Often suitable  for digitally
trade offs isynthesized images (compresses

(The better the compression, thewell)
worse the quality. Compression
usually  specified within JPEG
images as a percentage from 0%
(low quality) to 100% (high

quality))

Often suitable for images captured [Often unsuitable for images
from conventional camera / videdcaptured from conventional
(Compresses well, artefactscamera / video
invisible) (compresses poorly)

Often unsuitable for digitally
synthesized images (Artefacts /
degradation visible)
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MODULE 3 MULTIMEDIA DESIGN AND DEVELOPMENT
STRATEGIES

Unit 1 Multimedia Systems Development Life Cycle

Unit 2 Human Computer Interaction and User-Centered Design
Unit 3 Structure and Tools

Unit 4 Assembling a Multimedia Development Team

Unit5 e-Learning , Multimedia Learning and Cognitive

Principles in Multimedia Learning Design

INTRODUCTION

Multimedia applications like every other system involve management of financial, human
resources, equipment and time etc. for its objective to be achieved. The success or
otherwise of multimedia application would depend on the amount of knowledge put into it,
the appropriateness of equipment deployed, due to consideration to critical factors (e.g.
users’ peculiarities, costs), and so on. Multimedia applications must be designed,
developed and deployed within a given budgetary provisions and timing.

MULTIMEDIA SOFTWARE LIFE CYCLE MODELS

Multimedia applications development follows the system development life cycle that
has been adopted in the software engineering over the years. A software life cycle
IS a process which is organized in some order or sequence, structuring activities as a
whole. It involves activities (planning, design, development, testing, and deployment),
constraints (e.g. time, project size, budget estimates) and resources (e.g. manpower,
hardware, software) that produce an intended output. A process uses resources subject to
constraints and must have entry and exit criteria. Multimedia designers must take into
consideration for example, the relationship between a multimedia application’s size
and the time required to design and develop it; the relationship between its size and
quantity and quality of manpower required.

Generally, multimedia _system development life _cycle can be broken down to the
following processes or phases:

i. Preliminary Needs Assessment

ii. Analysis and Design

iii. Development

iv. Testing and Debugging

V. Deployment, Maintenance and Review

The various phases involve in development of multimedia applications are
collectively refer toas life cycle since the direction activity establishes new
objectives and goals this set the cycle turning through the phases. Realignment of
logical systems towards the set goals considering the constraints and available new
information is done when necessary. There a number_of models that have proposed
and deployed in_specification _and developments of software which are applicable
to multimedia system. Amongst are
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1. Classic Waterfall Life Cycle: The designer starts from the initial phase and move
on to the subsequent one on completion of the preceding phase. This model follows
the principle of gravity and therefore minimizes change and maximizes predictability
of costs and risks.  Projects can be divided into sub-components and given to sub-
team to complete within a time frame (milestones) and with specific output
(deliverables). Its limitation includes the fact that software requirements are
susceptible to changes even during design and development, and realistic model encourage
cycles.

2. Rapid Prototyping Model: A prototype is a partially developed product that
enables customers and developers to examine some aspect of a proposed system and
decide if it is suitable for a finished product. It is an abstraction of the real system
which can be subjected to series of tests in order to predict the behaviour of the proposed
system in real life. Potential users and domain experts reviewed the prototype by
summarizing findings and made recommendations. Multimedia authoring tools facilitate
prototyping. Prototyping is useful when the

i. workability of the proposed solution is in doubt; and
ii. objective is to minimize its impact during the system implementation.

The throwaway prototyping is similar to rapid prototyping but when the prototype has
been used to produce a kind of animated specification, it is thrown away, and the final
system is designed from scratch. It is useful for producing the requirements specification.

3. Iterative and Incremental Model: Incremental development of functionality
involves starting with small and functional subsystem, and adding additional (secondary)
functionality. Iterative development of overall system delivers a full system in the first
release, then changes the functionality of each subsystem with each new release. It
primitive forms of all three functions in the various versions (Releases) and then enhance
(making them faster, improving the interface, etc.) in subsequent releases.

4. Formal Methods: Formal methods rely on the wuse of mathematical
logic to achieve the software verification and validation to prove that its meet the
specification outlined in the preliminary phase. The goal is to enhance the process of
transiting from the initial phase (agreed specification) to machine executable code
(version) of the system through provision of better error-checking mechanism and
avoidance of future errors.

3.1 Preliminary Needs Assessment

The multimedia designers in consultation with its client (project owners), subject
expert and the intended users establish the general tasks which the proposed multimedia
application is to performed, and the constraints on its production. This may involve the
preliminary study of an existing system, be computerized or manual. The main
concerns in this phase include:

a. capturing the ideas and requirements of the clients
b. identifying the potential audience and users of the application
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c.finding out the benefit that will gain from developing the application
d. evaluating the feasibility and costs of the entire project, including
all tasks of production, testing and delivery

The most important thing to keep in mind during this stage is to strike a balance between
the benefit and the cost. A checklist when capturing the ideas and requirements include
the followings:

» Who will be the audience or end-users?

» What is the essence of the proposed multimedia application?

= What is the purposed message?

= How can the multimedia application be organized?

» What multimedia elements (text, sounds, and visuals) will best deliver the message?
* Would the available content material with  leverage the multimedia
application, such as videotape, music, documents, photographs, logos, advertisements,
marketing packages, and other artwork?

* Is the idea derivative from an existing theme which can be enhanced with
multimedia, or is it something totally new?

*What hardware is available for the development of the multimedia
application? Is it enough?

= How much storage space do you have? How much do you need?

= What hardware will be available to the multimedia application end users?

« What multimedia software is available to the multimedia application designer?
» What are the multimedia application designer’s capabilities and skills with both the
software and the hardware?

= Can the multimedia application be design and develop alone by one person or will it
require team work?

= How much time is available to complete the work?

 How much money is available? Would it be sufficient for the completion of the
project?

= How will the final project be distributed?

The essentials are to capture the ideas and to quickly evaluate the feasibility of
these ideas. The most important considerations are

i.Hardware: is the most common limiting factor for both development time and
final users

. very poor sound output device or even no sound device
. limited amount of storage

. very narrow network bandwidth

Ii. Software

the cost of development software is fairly high
the cost of software required in delivering to the end users may add up to a large sum

iii. Contents: wusing existing material or producing from scratch
. existing material may not match your requirement
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. they are copyrighted, permission may not be granted

. producing new material is expensive and time-consuming

Iv. Skill: Does it require very broad skill?

. computer skill
. artistic skill
. application domain skill

It is helpful to develop a pilot project or prototype before starting a full- scale
development

The deliverables should include the followings:

I. Terms of Reference;

i. Analysis of the functional system;

iii.  Summary of the software and hardware requirements;

iv.  Anoutline description of the proposed multimedia system; and v. Estimates of
costs, benefits and timeline (milestones).

3.2  Analysis and Design

The requirements identified in the earlier phase are used as the basis for constructing a
more detailed description (software specification) of the functionality of the proposed
system. The analysis focuses on the flow of data, and on the processes to be carried
out on these data to achieve the intended output. Tools require include flowcharts,
data flow diagrams, structured English etc. Succinctly, the phase can summarized as
follow:

Overview - description of project goals, conceptual approach

Storyboard - graphic outline of project interface, navigation, and key visual
components.

Application Flow - textual outline of all project components, timing, and
navigation options.

Content Description - detailed description of all content,
including: photography, computer graphics, text, video, voice- over audio, music, sound
effects, animations, etc.

Content  Acquisition  Plan - assignment of interactive multimedia,
customer and third party responsibilities in gathering, altering, and creating specific
content components.

Implementation Strategy - plan detailing all tasks, technologies, and
performance benchmarks required for remaining project phases.

Budget and Schedule - detail of costs, delivery dates, and milestones
associated with project deliverables.

Design involves the process of determining how the objectives outlined in the
software specification would be satisfied. The specification is used to construct a
design for the multimedia application including program details, files, records etc.
The focus at this stage is on the logical and physical structures and the processes which
access them.
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Designing a multimedia application is a creative activity which requires the knowledge
and skill with computer, talent in graphics arts, video and music, and knowledge of the
subject area of the application.

The design phase include the use of graphical outlines (Storyboarding) which describes the
project in exact detail using words and sketches for each screen images, sound, and
navigational choice. Storyboarding can be very detail, sketching out every screen, right
down to specific colour and shade, text contents, attributes, etc or it may just a
schematic guide. It is used to help plan the general organisation or content of
a presentation by recording and organizing ideas on index cards, or placed on
board/wall. The storyboard evolves as the media are collected and organised: new
ideas and refinements to the presentation. Storyboards can be drawn using traditional
media, such paper and pencil or by using a computer tool. The concept of
storyboarding has been by animators and their like for many years.

The design should follow some kind of arrangement (architecture) of the multimedia
information because a well-organised document will help the user find information
more efficiently and the architecture design should start early.

> [P [P

Linear Architecture

Non-Linear Architecture %

o Jel
/
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Hierarchical Architecture Composite Architecture

Figure Types of Design Architecture
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Different navigation structure may be supported by the same document hierarchy.
For example, by subject and by time

3.2.1 Design: User Interface

The main emphasis in the design of multimedia user interface in multimedia
application centers on

I. Contents selection is the key to convey the information to the user
and the content can be influenced by constraints imposed by the

. size and complexity of the presentation

. quality of information

. limitation of the display hardware

. need for presentation completeness and coherence

ii. Media must be chosen to be “adequate”
For example, to present a course on how to play tennis, graphics and video are more
suitable than text only.

iii.  Coordination —composition of different media
3.2.2 User interface techniques

. Keyboard —fixed control commands are assigned to keys
Buttons in a system with Graphical User Interface (GUI)
Scroll bars—bars may be attached to the side of the application window

. Special device —joystick may be a more natural way of controlling the
device
. Direct manipulation of the video window —clicking a point in the application

window, the device can be manipulated

Navigation —refers to the sequence in which the application progresses

. Direct navigation—completely predefined
. Free-form navigation— the user determines the sequence of actions
. Browse navigation—the user is provided a large number of choices

An important aspect of any multimedia system is to maintain a clear perspective and the
relationship between those objects

Designing user interface

. A good user interface is defined as one that is perceived to be efficient and
intuitive by most users
. A good user interface can be designed by following some structured guidelines:

Planning the overall structure of the application
Planning the content of the application
Planning the interactive behaviour
Planning the look and feel of the application
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3.2.2 User-friendliness

User-friendliness is the primary goal of multimedia interface. The users do not need a
long period of time before they can use the system, the learning phase should be quite
simple. Users should find it easy to remember instructions and the instructions for the user
interface should enable effective use of the application.  Logically connected functions
should be presented together and in a similar way. Graphical symbols are more
effective than textual input and output. Different media should be able to be exchanged
and shared among different applications. Prompt feedback after a user initiates an action
IS necessary.

3.2 Development

The development phase is when the multimedia project is actually rendered. At this
stage, the project plan (and storyboard) must be filled with all details. The tasks to be
performed in this phase are acquiring all media elements and composing the elements
according to the storyboard.  This is the phase when the designer’s artistic talent
and technical knowledge are in high demand. The methods of tracking media elements and
the progress of work, and also provision for solving any technical problem that may arise
are put in place.

3.3.1 Copyrights

If you acquire content from somewhere, it is very important to know who has the
right of the work. Some of the works protected by copyright include computer software,
technical innovation and design, literary works, dramatic works, musical works, artistic
works, sound recordings, cinematograph films,  television  broadcast,  sound
broadcasts and published editions of works etc.

It is necessary to license the rights to use copyrighted material before using it in a
multimedia project. This may be done by negotiating the outright ownership of
copyrighted material or procuring the rights to use that material. The designers must
consider what rights to require:

. How will the material be used and distributed

. Is the license for a fixed period

. Is the license exclusive or non-exclusive

. Where will your product be distributed

. Does the content owner have the authority to assign right to you
. Will the copyright owner receive remuneration for the license
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In summary, the design may observe the following outline steps:

Final Copy and Content Development

o Create, acquire and prepare all photographs, user interface graphics, and
other illustrations

o Model, animate and render all 3D animation components

o Record, digitize and composite all audio and video components

o Edit and process all textual components

Acquire and prepare all external components such as install software,
databases linked websites, etc.
Programming, Testing & Mastering
Build authoring platform framework
Import content
Develop all programming components
Test for proper function and performance targets
Optimize performance for each platform
Burn beta version for customer content review and functional testing
Burn gold master for replication
Packaging and Support Literature Design
Design and layout packaging and collateral materials
Proof and revise as needed
Produce make-ready films and/or digital files

¢ 0O 0O 0O 0O 0O O O

o O

3.3 Testing and Debugging

A multimedia application may be used by many different users, many of who knows
very little about computers, and on a variety of heterogeneous platforms and
configurations. Therefore, it is important to test the product in a wide range of
configurations. Like all other software, testing and debugging is an important and
time-consuming phase. There are two types of testing namely

i. Alpha testing: an internal activity whereby the multimedia application is
tested by in-house team; and

ii. Beta testing involves a wider range of testers (real users) and should not
include persons who have been involved in the production of the multimedia
application.
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3.4 Deployment, Maintenance and Review

3.5.1 Deployment

There are two issues to be considered before a multimedia application is deployed and they
are

I. Delivery Tools; and

ii. Deployment Strategies.

3511 Delivery Tools

The delivery tools should be planned for early in the development process. CD-ROM
and Internet are the two most popular means of delivering multimedia applications. All
necessary distribution elements such as:

. media elements: e.g. movie clips, sound clips, external casts

. runtime libraries: e.g. Director runtime

. drivers: e.g. DirectX

. helper programs: e.g. QuickTime viewer, Acrobat Reader

. installation program, compression and decompression programs

should be included in the final package. The following steps may be following in the
final packaging and distribution of the multimedia application:

Customization as required

o Prepare additional versions for specialized usage
CD Replication, Printing when required
Manufacture CD-ROMs
Print and/or label CD-ROMs

Packaging/Distribution

Print CD-ROM packaging and collateral materials
Assemble/stuff and prepare for distribution
Distribute

3.5.1.2 Delivery Strategies
According to the means of delivery and the target audience, the designer should plan how

the application is to be installed and used. Delivery strategies include direct changeover,
parallel running and phased changeover; however these strategies may also be combined.
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1. Direct Changeover: This is a complete replacement of the old system by the new
system in one move. It assumes that the multimedia application is well organized,
well implemented, well tested and the wuser has well trained to effectively use
the application.

Time

v

Figure Direct Changeover

2. Parallel Running: The old system and the new system are deploy side by
side and then cross checked to ascertain the effectiveness of the new system. The old
system is not discarded until the new system has been proved to be okay. Its drawbacks
include the extra costs of running the two systems concurrently, and the complexity
of running two different systems alongside each other.

Parallel Period
Old System

New System

»

»  Time

Figure .... Parallel Running
3. Phased Changeover: This involves a sequence of direct changeover in
small proportion; the new system being introduced in piecemeal fashion. Thus, reducing

the inherent risks in direct changeover and allows both the designers and end-users to
learn from any mistakes that may occur during the deployment stage.

Old System 4’—I_,_l
New System ,—,—,_]—

Figure ...... Phased Chnageover

68



CIT 735 APPLICATION SOFTWARE DESIGN AND MULTIMEDIA

3.5.3 Maintenance

The ongoing development of a multimedia application to add new products,
functionality, and distribution channels requires adding and revising content and
functionality, and convert to additional media types (e.g. video, web, DVD, etc.).

Maintenance involves making sure that the multimedia applications runs in operational
use and continues to do so for as long as it is required. It includes correcting any
errors which have remained undetected, improving the implementation of system
modules where necessary, and enhancing the functionality of the application whenever
desired by the clients/end-users.

3.5.4 Review

The post-implementation review takes place only after the multimedia application has
been running error-free for a number of cycles.  Some specific aspects of the
multimedia application are studied over a reasonable period and the findings are
documented. These aspects will include the following:

I Timing

The actual time taken to complete the various processes in the multimedia application and
the time it takes for enquiries to be satisfied are studied. The aim is to obtain
feedback when compared with the term of reference.

ii. User Satisfaction
The usefulness of the multimedia application would depend on how satisfied the end-
user is with the system, especially with error-recovery and training methods.

iii.  Throughput
This would enable the designer to measure how many transactions and enquiries
the multimedia application is able to process within a given timeframe.

iv. Error-rates
The number and level of errors that occur during process are also considered.

V. Gray or Problem Areas
The designer must record any problem or gray area brought to his attention by the end-
user in his evaluation report.

vi.  Actual Costs
The total actual costs incurred in running the multimedia application are compared with
the estimated running costs in the feasibility study.

Vili. Realized Benefits

The actual benefits realized from using the multimedia application are compared with the
expected benefits stated in the feasibility study.
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3.6  Issues in Multimedia Applications Design

Some additional issues involved in multimedia content and technical design are discussed
as follow:

3.6.1 Content Design
Content design deals with what to say and what media/tool to use. In multimedia, there
are five ways to format and deliver the message, namely,

i. write the message;

ii. illustrate the message;

li.  wiggle the message;

\2 hear the message; and

V. interact with the message.

3.6.1.1 Scripting (writing) the Message
A well-scripted message would require that the multimedia application designer

1. Understand the audience of the proposed multimedia application and correctly
address them.

2. Keep his writing as simple as possible. (e.g., write out the full message(s)
first, and then shorten it.)

3. Make sure technologies used complement each other.

3.6.1.2 lllustrating the Message (Graphics)

The designer should make use of pictures and graphical illustrations to effectively deliver
the intended messages. Visual contents are retained in the human memory longer
than audio and writing message. The graphical styles such as the fonts (typeface,
size, colour, style etc.) and colours (pastels, earth-colors, metallic, primary color and
neon color) should be considered.

3.6.1.3 Wiggling the Message (Animation)

Sometimes, the message is better illustrated with animated objects. Objects are
animated to achieve some purposes such as stressing a point, improving information
delivery, enhancing emotional impact, indicating the passage of time, showing transition
(motion, cut, fade, dissolve and wipes). Various animation styles include character
animation (revealing emotion, stimulating movement, enhancing visual style), highlights
and sparkles), moving text, and live or digitized video.

3.6.1.4 Hearing the Message (Audio)
The following constitute the various ways audio message could be created:

1. Music: set the mood of the presentation, enhance the emotion, illustrate points;
2.Sound effects: make specific points, e.g., squeaky doors, explosions, wind
etc; and

3. Narration: most direct message, often effective.
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3.6.1.5 Interacting with the Message (Interactivity)

Interacting with multimedia contents ensures that the multimedia user come into
contact with two learning domains, affective and psychomotor. Interaction enhances
content comprehension, retention and recall. This due to the fact that human being
remembered more than

70% of what they interacts with or put into practice.  Thus, interactive multimedia
provides a convenient means of setting up some simulated laboratory and practical
exercises in the learning environments.

3.7  Technical Design

Technological factors may limit the effectiveness of the multimedia presentation and such
technical parameters that affect the design and delivery of multimedia applications
include:

1. Video Mode and Computer Platform
There are many "portable”, "cross-platform™ software and "run- time modules”, but
many of them lose quality/performance during the translation.

Video Mode Resolution Colors
CGA 320 x 200 4
MCGA 320 x 200 256
EGA 640 x 350 16
VGA 640 x 480 256
S-VGA 1,024 x 768 $>%$= 256
S-VGA 1,280 x 1,024  $>%$= 256

16-bit color --$>$ 65536 colors
24-bit color --$>$ 16.7 million colors

2. Memory and Disk Space Requirement

Rapid progress in hardware alleviates this problem, but software requirements changes
more rapidly, especially the multimedia ones.

3. Delivery Mode

a. Live Presentation: short checking list  for hardware/software
requirements:

= type of graphics card

video memory (1 MB, 2 MB, 4 MB, etc.)

. access time of hard disk (important for real-time video)
type of sound card (support for General MIDI)

audio-video software
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b. Delivery by diskette: small in size, slow to install

C. Delivery by CD-ROM: large capacity, access time of CD-ROM drives is longer
than hard-disk drives.

d.  Electronic Delivery (ftp, www, etc.): depends on baud rate, network connection,
bandwidth and monthly bill.

3.8  Visual Design

Here we summarize factors that should be considers in the visual design of a multimedia
presentation:

1. Themes and Styles: A multimedia presentation should have a consistent theme or
style, it should not be disjointed and cluttered with multiple themes. The choice of
theme the style depends onthe styles and emotions of the audience peculiarities
the multimedia presentation is addressing. Some possible themes include:

a. Traditional theme: straightforward, simple, often informative but not as interesting;
b. Cartoon theme: interesting or entertaining and

must be consistent with the character's personality;

c. Technical theme: include blueprints, 3D models of the product, e.g., start with a
drawing, then transformed into a rendered image. Reveals adequate technical
information and gives impression of solid design and construction; and

d. High Tech theme: contemporary computer art

work (morphing, texture mapping, metal texture, explosions), attractive, and easy to
animate.

Color schemes and art styles include:
a. Natural and Floral: getting back to nature
(outdoor scenes, e.g., mountains, lakes, ...); and
b. Oil paints, water colours, colored pencils, pastels. the art styles can be
combined with e.g., cartoon or high tech themes

2. Pace and Running Length Guidelines include:

a. Allow a block of text to be slowly read twice;

b. Transition time should be an indication of real-time.

. dissolve - time delay, scene change

. cut - two views of same scene at same time, or abrupt scene change
: Running length

. self running presentation: 2-3 minutes

. limited interaction: 5-6 minutes

. complete analytical, hands-on demo: < 15 minutes

. with questions, discussions: > 30 minutes

d. Interlude: build in breaks for long presentations

3. Basic Layout
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(@  Title (b) Action area (c) Narration (d) Dialog (e) Interactive controls

- make sure that the information delivery path in the layout is smooth, not
irregular/jumpy

-use headlines/subtitles, additional shapes, buttons, fonts, backgrounds and textures
to enhance the visual appearance.

UNIT 4 ASSEMBLING A MULTIMEDIA DEVELOPMENT TEAM
CONTENTS

1.0  Introduction

2.0  Objectives

3.0  Project Manager

3.1  Graphic Designer and Art Director
3.2 Script / Content Writer / Science Communicator
3.3 Sound Designer and Sound Engineer
3.4  Videographer and Video Producer
3.5  Subject Matter Expert

3.6 Instructional Designer

3.7 Multimedia Programmers

3.8 Quality Assurance Engineer

INTRODUCTION

Multimedia design, development and deployment require a multi- disciplinary approach
since diverse subject areas are involved in single multimedia applications. In actual fact
real-life multimedia applications require pooling together teams of many skilled and
knowledgeable people in different areas such as computer science, instructional
technology, physics, visual and graphical arts, measurement and evaluations,
science communication, voice and screen actors, management, psychology,
mathematics (logic, algebra & geometry), digital content repository, film production and
photography etc.

For instance, multimedia data elements such as sound require expertise in sound
engineering and management; image and objects would require special skills in visual
and graphics including 2D and 3D animation, video and audio production, image
design and manipulation, and detailed web design; multimedia learning and e-learning
systems would require expertise in curriculum design and instructional technology
beside others; multimedia programming involve extensive knowledge in all web-based
programming languages and techniques; and so on.

In all management plays an important role in assembling all the needed resources, and
coordinating this array of personnel from diverse areas to achieve the team overall goals
and objectives. Also the multimedia life cycle (analysis, design, implementation, testing,
delivery and maintenance) must be effectively coordinated.
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3.0 PROJECT MANAGER

Multimedia applications like every other project require someone with human,
material, machine, financial resources management skills. Such a person refer to as
project manager (or project consultant or producer or team leader) coordinates the entire
development of the multimedia project and  facilitate team-spirit, team-binding
and  unity among members of his team. He is responsible for overseeing project
timeline and priorities, quality of the final product, allocation of funds, and the time
management of the project, communicating the team’s objectives and achievement to
team members, assists in personnel recruitment and selection, delegating duties and
supervision, maintaining conducive work environment, and documentation. He has a
clear understanding of the team's roles and responsibilities, and sees to it that members
remain focus on their jobs especially in times of difficulties. He is a dynamic, proactive
and innovative individual with excellent team-working skills and the ability to liaise
with a wide range of users.

He keeps records such as budget estimates, schedules, creative sessions, time sheets,
illness, invoices, and team dynamics or personnel turnover. He provides answers to
questions such as:

. Why is important to have a project timeline and set priorities?
. Why is it important to schedule meetings?

. Why is it important to keep minutes of meetings?

. Why is it important to have a project librarian?

. Where would you keep documents for your project?

Key activities of a multimedia project manager include:

Coordinates initial start up meetings between all parties;

. Schedules additional meeting throughout the project;
. Clarify, publish, and communicate timelines and milestones (establish deadlines);
. Breakdown the allocation of tasks and ensure all agencies are aware of their
schedule and responsibilities;
. Monitor the allocation of tasks and the use of resources;

Monitor progress of work in development of the multimedia presentation;
. Manage the allocation of financial resources;
. Ensure quality control throughout the project and sign off the final deliverable;
. Evaluate the process and produce a project completion report; and
. Market the final product; ensure the product reaches the target audience.

3.1  Graphic Designer and Art Director

The graphic designer assembles together images, typography or motion graphics to create
a piece of design primarily for published, printed or electronic media. He knows how to
organize and communicate visual information effectively in a way that is both
accessible and memorable. He is able to transform textual and mental information
into visual/graphical information effectively. He is responsible for creating interactive
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and creative design that stimulates user’s interest in the multimedia presentations and

which leaves a lasting impression on their minds. He design illustrations, user interfaces
and web designs, and determines how multimedia contents are presented to the users.

Some of the skills and attributes required in a graphic designer include:

. Proficiency in one or more graphic design software programs, relevant to
the job function. A web designer should understand how to work with XML,
HTML and basic web programming scripts while a print designer should understand the
processes involved in printing to be able to produce press-ready artwork;

. Good in solving visual communication problems or challenges.

He should be able to identify the communications issue, gather and analyze
information related to the issue, and generate potential approaches aimed at solving
the problem;

. Good understanding of the social and cultural norms of that audience in
order to develop visual solutions that are perceived as relevant, understandable and
effective;

= thorough understanding of production and rendering methods such as colour,
drawing, offset printing, photography, and time- based and interactive media (film,
video, computer multimedia);

. produce design solutions to communicate their clients’ messages with  high
visual impact using production medium such as websites, advertising, books,
magazines,  posters,  computer games, product packaging, exhibitions and displays,
corporate communications and corporate identity;

. meet the end-users or client's objectives by developing creative ideas and
concepts, choosing appropriate media and style, and ultimately working to an agreed
brief with the end-users or clients; and

. have creative flair, up-to-date knowledge of industry software and a
professional approach to time, costs and deadlines.

The graphic designer’s roles within a multimedia development team include:

meeting clients or account managers to discuss the business objectives and
requirements of the job;
interpreting the client's business needs and developing a concept
to suit their purpose;
- estimating the time required to complete the work and providing quotes for clients;

. developing design briefs by gathering information and data
through research to clarify design issues;
. thinking creatively to produce new ideas and concepts;

using innovation to redefine a design brief within the constraints of cost and time

and client;
. presenting finalised ideas and concepts to clients or account
managers;
- working with a wide range of media, including photography and computer-aided
design (CAD);

proofreading to produce accurate and high-quality work;

contributing ideas and design artwork to the overall brief;

demonstrating illustrative skills with rough sketches;
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. keeping abreast of emerging technologies in new media,
particularly design programmes such as Quark Xpress, FreeHand, Illustrator, Photoshop,
3D Studio, Acrobat, Director, Dreamweaver and Flash, as most graphic design work is
now completed on a computer;
. working as part of a team with printers, copywriters,
photographers, other designers, account executives, web developers and
marketing specialists; and
. working to meet tight deadlines.

The ART DIRECTOR is in charge of the overall visual appearance and how it
communicates visually, stimulates moods, contrasts features, and psychologically appeals
to a target audience. He makes decisions about which visual elements to use, what artistic
style to use, and when to use motion.

He translates desired moods, messages, concepts, and underdeveloped ideas into
imagery by brainstorming with other team members. He is ultimately responsible for
solidifying the vision of the collective imagination while resolving conflicting agendas and
inconsistencies between the various individual inputs.

3.2 Script/ Content Writer / Science Communicator

A scriptwriter may refer to a person who writes screenplays for film and television
(Screenwriter), or a person who writes scripts for live-action entertainment (Playwright) or
a person who write scripts for comedy sketches, political speeches, documentaries and
other presentations. He is versatile in communication and writing skills, and
communicates clearly through written text. He gleaned information from subject
matter experts, synthesize it, and then communicate it in a clear and concise
manner.

It is duty to adapt the script to the multimedia environment and make sure that the
words in the script counts by creating desire impression in the mind of end-users
(audience). Computer-based multimedia requires that the  scriptwriter to be
knowledgeable about multimedia data elements (audio, video, text, graphics, and
animation) and should adapt them appropriately for the purpose (which might be
education, training, promotion, reference, entertainment, and games) of the multimedia
presentation.

The scriptwriter ensures that the rules of the chosen language are responsibly adapted to
suite the demands and opportunities presented by computer technology which is
characterized by new media and non- traditional methods. Here are some general
guidelines when writing scripts for multimedia presentations:

keep the explanation of a concept or process concise, simpler and easier to
understand;
keep scripts in the active voice which is more direct, and usually shorter than a
passive construction;
present information in digestible chunks;
make sure all text can be easily understood and read the scripts out loud;
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-ensure the script and other multimedia data elements complement one another to allow
both the ears and the eyes receive and synchronize the intended messages convey in the
multimedia presentation for easier comprehension by the mind; and

-allow users some measure of control over the presentation by incorporating
interactivity-led words in the script. Interactivity allows each user to actively
participate in the usage (viewing) process, instead of passively watching the
multimedia presentation. The nature of the material in the multimedia presentation
determines the amount of interactivity that should be permitted.

3.3  Sound Designer and Sound Engineer

The sound designer works with the project manager to shape an overall, consistent
soundtrack that exploits the expressive possibilities of the sound medium. Sound
designer can also refer to a person brought on to create just one kind of sound effect.
He has good ear for voice-overs and sound effects, and knows the inherent qualities and
constraints of a medium which produces desire sound to the multimedia content. He
chooses an appropriate sound effect that accompanies a narration. Specifically, he is
responsible for designing acoustics for audio visual, audio and video conferencing,
and determines the noise impact in the multimedia application.

Sound designers study the script and gather as much information as they can about any
sound or music required to create the appropriate sound that would suit the theme of
the multimedia presentation and as well as its content. Sound designer meet with the
project manager and the design team at the very much beginning of the project in
other to have good and clear understanding of the content in the multimedia
presentation.

Sound designers create sound effects in multimedia presentations to:

motivate actions during actual running of the multimedia presentation and
indicate events taking place after running it;

. establish the time of day, season and weather;
. locate the action in a specific place;
. create mood and changes in mood;

stimulate audience expectations of what is to come;
provide information about the characters;
build transitions between scenes; and
. offer shortcuts that rapidly advance the plot or recall past events;
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The sound designer combines and varies the five controllable properties (pitch, quality,
volume, direction and duration) of sound to create unique effects or music required
by the production of the multimedia presentation. He makes use of planning tools
such as

. Plot: A list of all the music and sound cues for each act/scene. It indicates
where the sound of music occurs, the page number of the script where it appears,
precisely when it begins and ends, and the equipment that will be used to produce it.

. System layout: A system layout shows the type and location of speakers on
stage, on the set and in the auditorium. The system layout may also include a layout
of how all of the sound equipment will be interconnected.

. Cue sheet: A version of the sound plot to be used by the sound technicians
who will run the equipment during the performance.

The sound engineer takes the sound design by the sound designer and ensures that it can
be created in a given space. This involves selecting equipment to reproduce the various
sound elements required, installing and testing it, and usually running the actual
multimedia presentation.

The sound engineer’s roles within a multimedia team include:

= has responsibility for some aspect of the sound at during presentations;
= taking care of setting up amps, volume, equalizers, speakers;

3.4 Videographer and Video Producer

A videographer records moving images and sound on tape, disk, other electro-mechanical
device, broadcasting live, or even on actual celluloid film in some cases. He has good
eyes for video and makes every megabyte count by recording important details which
enhance the understanding of the multimedia contents and stimulates viewers’
interest in the multimedia presentation. He is usually responsible for the camera, sound,
and lighting and sometimes work underneath a director. In smaller productions (e.g.
corporate and event videos), a videographer often works alone or as part of a two or three
person team of camera operators and lighting and sound technicians.

Videographers are distinguished from cinematographers in that they manage smaller,
event scale productions (weddings, short documentaries, short fiction pieces, simple
commercials, simple training videos). Due to reduced budget compared to full
length feature productions, videographers typically use electro-mechanical cameras
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while cinematographers record images on film. The advent of digital cinematography,
however, has blurred this distinction.

Videographers maintain and operate a variety of video equipment, edit footage, and
stay up to date with technological advances. The videographer is responsible for
the maintenance and operation of the satellite, maintaining and repairing video walls,
video tape editing in various formats, creating graphics for the cruise events and
information channel, shooting and editing video tapes, programming the broadcast
room such as tuning in TV, radio and playing of movies.

On the other hand, video producer provides information about audio and video
production, DVD authoring and duplication, corporate presentations and audio/visuals.
Video producers work closely with all members of the multimedia development team on
video productions to ensure that the process goes smoothly and is completed on time.
The video producer must have a good working knowledge of all aspects of production
from set design, lighting and audio through to editing, filming and working with
scripts.

The video producer liaises with the project manager in making sure that all required
supplies, equipment and staff are in the correct place at the correct time. Coordinating
these services may be a large part of the video producer’s daily responsibilities prior to
the commencement of shooting. Once filming is in progress the video producer will
work to coordinate the actual filming, ensuring that all aspects of filming are completed
correctly.

A video producer must be creative and have an ability to work with various people
and various settings, and budgets to end up with just what was wanted at the end of
the project. Good communication skills as well as patience and the ability to motivate
others are needed in a video producer.

The video producer’s roles within a multimedia team include:

coordinating all aspects of the filming production and confirming
that all people, supplies and equipment will be available when required;
handling all logistics of the filming including making sure that
script writers, graphic designers, subject matter experts, instruction designers etc. have
completed all necessary paperwork and meet all requirements in the design specification;
editing and processing the video to produce exactly what the project manager or
end-user required;

troubleshooting issues with filming, modifying or changing scripts, or
adding additional aspects to the filming to enhance the production; and

communicating with directors or clients to determine exactly what they
want and then producing that in the studio.

3.5 Subject Matter Expert
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The subject matter expert is someone skilled and knowledgeable in a given topic area

and has experience teaching the topic. He is versatile in tutoring, mentoring and coaching
the subject matter, and therefore serves as the primary source of authoring for the
multimedia content. He identifies background resources for building the multimedia
contents and reviews content design for factual integrity, completeness and educational
effectiveness. He is not necessarily the multimedia a designer or developer but
serves a complementary role in the multimedia development team. He knows the
subject matter very well and is able to use the right messaging and terminology when
teaching the subject matter.

The subject matter expert is critical to the validity of the content of Multimedia
presentations.  Therefore, the use of subject matter experts in providing content
expertise advice toward the development of the product should not be overlooked.
Subject matter experts have a stake in the multimedia project because it will reflect
their degree of expertise and knowledge. In most cases they don’t end up as the end-
users, but certainly are involved in providing the technical expertise to the content. The
quality of the content will only be as good as the expertise of the contracted subject matter
experts involved in the multimedia project.

Multimedia project manager must ensure that the subject matter experts are available,
understand their role, and most importantly be left to provide subject matter expertise only.
It is advisable to allow subject matter expert to be focus on content, rather on the
development of the multimedia presentation.

The following areas of general expertise are assumed as prerequisites and provide a basis
for the competencies expected of a subject matter expert:

- agood all round knowledge of the subject-matter of the course;
the background pedagogy that underpins the course;
-a good understanding of the limits and limitations of the information and communications
technology;
- acloser working and sharing relationship with the learner;
-provide learners with "positive" support and "positive" encouragement; and
- arole of mentor/counselor as well as academic advisor

3.6 Instructional Designer

The instructional designer is a very critical key to success for effective multimedia
development since he can assess educational needs and design and evaluate
lessons. All multimedia presentations geared towards creating a dynamic, effective
learning environment must have legitimate and sound instruction design and strategy built
into the presentations.

The instructional designer’s roles within a multimedia team include:

providing advice on effective and efficient learning strategies;
-working with the subject matter experts to breakdown the content and organize it into
reasonable chunks;
- designing effective learning strategies and build them into the
multimedia project;
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.conducting needs assessment and matching design to instructional needs;
- organizing, managing, and delivering information in such a way
to create an effective learning environment;
-developing introductions, main content body, review, application, an motivational
segments of the multimedia presentation;
- identifying and studying the target audience and designs the level
of learning appropriate to their needs;
-identifying the key components of effective multimedia development and
delivery, and ensures this built into the project;
-conducting research without agencies to acquire additional resources and
references;
- designing a logical and structured format to the design decision
throughout the development of the project; and
-evaluating the final “pilot" product and make necessary adjustments to fine-
tune the educational effectiveness of the multimedia.

3.7 Multimedia Programmers

Multimedia programmers translate the requirements of the end-users, graphic designer,
subject ~matter expert, instruction designer, and other team members into the
programming language, working out the logical steps that must be taken by the
computer to do a task so that the multimedia presentation works as planned. A
multimedia programmer is a software engineer who integrates all of the multimedia
elements into a seamless whole using an authoring language or programming language.
Multimedia programmers make computer programs that use text, sound, graphics and
pictures, 2D/3D modeling and virtual reality.

The roles of a multimedia programmer within a multimedia team include:

. meeting clients’ (end-users) needs in the most effective way, and ensuring that the
end product is both attractive and user friendly;

. creating multimedia presentations that use more than one way to communicate
information. i.e. they may combine the different media elements such as sound, text,
graphics, animation and video pictures to communicate an intended message, or
concept/idea;

. collaborating with other team members (e.g. script writers, artists, graphic
designers, animators and sound engineers) in developing the content of the multimedia
presentations;

. translating the design into a language that the computer can understand by
designing and writing computer codes, testing these codes and fixing bugs;

. developing games, educational software, websites, film, television and digital video
productions;

. putting the different media in logically sequential order; making animation happen
at the right time; using sound effects appropriately and generally implementing the
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instructions of the creative designer; and

. designing and writing web pages, program the links to databases, or create graphic
effects for film studios.

Some of the relevant skills and attributes required to be a multimedia programmer include:

-the ability to mentally construct and communicate multimedia ideas;

-presenting ideas and information in writing, and explaining these ideas and information to
end-users and team members;

- strong communication and interpersonal, skills to swap ideas, and

to explain your work clearly and concisely to people who may not have much computer
knowledge;

-have a clear understanding and appreciation of other members' role in the multimedia
development team;

-enjoy solving problems, exercising logical thinking and working on a project from start to
finish;

-have creative ideas about designs and styles, and the ability to create an accessible
computer / user interface;

- strong interest in information technology;

- knowledge of Internet programming languages and applications;

-the ability to incorporate elements of different media into a whole presentation;

- good teamwork and co-operation with other team members;

-good organizational skills as well as ability to plan and meet tight deadlines, and ability to
work well under pressure;

- preciseness, persistence, analytic, accuracy open mind to future

possibilities and paying attention to minutest detail; and

- willingness to learn and improves, and be up-to-date with latest developments in a
constantly changing technology industry and improving.

3.8 Quality Assurance Engineer

Quality assurance (QA) engineers are responsible for assuring that the developed
multimedia presentations are effective and free from errors (defects) or operational
problems by testing them to make sure they works according to design specification
and meet users’ need. The test is carried out under various working conditions or for
verifying the information the  correctness of the content in the multimedia
presentation. QA engineers verify and guarantee the accuracy or performance of the
multimedia presentation as well as troubleshoot the correction of any problems or issues
throughout the development of the presentation through systematic quality auditing,
proofing and compliancy checks at key points in the project development cycle.

The QA engineer is the tester for the product and is required to use it both as
recommended and otherwise. His ability to think of how consumers may use the
product incorrectly is important in liability and other legal issues for the multimedia
team. The QA engineer is also expected to provide feedback on the user-friendliness (or
otherwise)
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aspects of the product, and should suggest ideas for modifications and improvements.
QA engineer should possess the following attributes:

= an understanding of the multimedia presentation;

. the goals of the multimedia development team for the multimedia presentation;

= good background in multimedia design and development;

. experienced in data entry, accurate record keeping and attention to detail; and

. effective communication skills and the ability to work as part of the team in developing

and testing products is key;

= they are problem-solvers who like a good puzzle;

. persistence, meticulous, thorough, detail-oriented, and enjoy tinkering; and

. understand the problems that users can encounter and able to build bridge between
end-users and programmers, so they must.

The roles of a quality assurance engineer within a multimedia team include:

. discussing the multimedia presentations to be tested with the development team and
the end-users;

. testing and assessing the effectiveness, accuracy or safety of multimedia;
presentations based on existing safety standards or performance guidelines;

. entering data entry, recording of results and completion of paperwork in a timely
fashion;

. making sure that all the programs work properly and that everything in a Web site

functions according to plan;

- trying and making things not work so the programmer can catch

errors before they occur;

. troubleshooting inaccuracies or problems in the multimedia presentations; and
meeting with the multimedia development team to share results

and recommendations.
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MODULE 4 MULTIMEDIA AUTHORING: FLASH TECHNOLOGY AND
DEVELOPMENT

Unit 1 Overview of Flash Technology

Unit 2 Flash Animation

Unit 3 Introduction Dreamweaver and Cascading Style Sheets
Unit 4 Flash Development: Dynamic HTML and AJAX

UNIT 1 OVERVIEW OF FLASH TECHNOLOGY

1.0 INTRODUCTION

Flash is a tool for creating interactive and animated Web sites. Adobe Flash  (formerly
Macromedia Flash) is a multimedia platform originally acquired by Macromedia and
currently developed and distributed by Adobe Systems.

DEFINITIONS

Flash is a multimedia graphics program especially for use on the Web and which enables a
user to create interactive "movies" on the Web. It uses vector graphics, which means that the
graphics can be scaled to any size without losing clarity/quality and Flash does not
require programming skills and is easy to learn.

Since its introduction in 1996, Flash has become a popular method for adding animation and
interactivity to web pages. Flash is commonly used to create animation, advertisements, and
various web page Flash components, to integrate video into web pages, and more recently,
to develop rich Internet applications.

Flash can manipulate vector and raster graphics, and supports bidirectional streaming of
audio and video. It contains a scripting language called Action Script. Several software products,
systems, and devices are able to create or display Flash content, including Adobe Flash
Player, which is available free for most common web browsers, some mobile phones and for
other electronic devices (using Flash Lite). The Adobe Flash Professional multimedia authoring
program is used to create content for the Adobe Engagement Platform, such as web applications,
games and movies, and content for mobile phones and other embedded devices.

Files in the SWF format, traditionally called "ShockWave Flash" movies, "Flash movies"
or "Flash games", usually have a. swf file extension and may be an object of a web page,
strictly "played” in a standalone Flash Player, or incorporated into a Projector, a self-
executing Flash movie (with the .exe extension in Microsoft Windows or. hgx for Macintosh).
Flash Video files have a. flv file extension and are either used from within. swf files or
played through a flv-aware player, such as VLC, or QuickTime and Windows Media Player
with external codecs added.

Animated images and Java applets are often used to create dynamic effects on Web pages.
The advantages of Flash are:
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Flash loads much faster than animated images
Flash allows interactivity, animated images do not
Flash does not require programming skills, java applets do

Flash Versions include

Macromedia Flash, Flash MX ... Flash 8

Much better help

New components

Better video quality

ActionScript 2.0

Adobe Flash CS3, CS4

Flash 8 is available on Lehigh LANSs; trial version of Adobe Flash CS4 on web

O 0O 0O O O OO0

3.3 Flash Drawing tools

Flash provides a good interface for creating graphics from scratch beside its usefulness for
creating multimedia content. Graphics created in Flash can be saved in gif, jpg, png or other
formats. Its vector capabilities allow for easy scaling without loss in quality or detail. Flash
drawing is a vector graphic format, similar to Illustrator or Freehand. Vector drawings from
other programs can be imported into Flash and edited or illustrations can be created directly in
Flash.

There are five drawing tools in Flash, the rest are used to modify various aspects of the drawing.
The drawing tools are found in Drawing Toolbar, which should be docked at the left side of
the screen when you first start Flash. If you don't have this toolbar open, click on Window -
Toolbar..., check the box in front of Drawing and click OK.

Activity 2 Draw Shapes

a. Create shapes by using the Line, Rectangle, Oval, Pen, or Pencil

Tools

b. Select shapes by using the Selection Tool and the Lasso Tool c.  Edit shapes by using
Selection Tool and the Eraser Tool

d. View, move, copy, and delete shapes

Activity 3  Draw Rectangles and Squares

a. To draw a rectangle:

I. Select [o]

Ii. Place the insertion point on the Stage iii. Drag diagonally
b. To draw a square:

i. Hold down the Shift key while dragging

Activity 4  Create Rounded Rectangles

a Click
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b. Click the Round Rectangle Radius modifier

C. Specify the Corner Radius and click OK
d. Place the insertion point and drag diagonally

Activity 5 Draw an Ovals and Circles

a. To draw an oval:

i. Select @

Ii. Place the insertion point on the stage iii. Drag diagonally
b. To draw a circle:
i. Hold down the Shift key while dragging

Activity 6  Using the Pen Tool

a. To create a straight line:

i. Select IE‘

ii. Click where you want the line to start

iii. Click at a point where you want to place the end point iv. Drag the direction line
b. To create a closed path:

i.  Click the first anchor point ii. Drag to adjust the curve

Activity 7 Using the Pencil Tool

a. Select

b. Select an option from Pencil Mode list c. Place the pointer and drag
Activity 8  Copying and deleting shapes

a. To copy a shape:

i. Select the shape

ii. Choose Edit, Copy iii. Choose Edit, Paste
b. To delete a shape:

I. Select the shape

ii. Choose Edit, Clear

Activity 9 View Shapes

a. The Zoom tool «
I. Zoom In to magnify a shape ii. Zoom Out to reduce a shape
b. The Hand tool

iii. To move the Stage
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Activity 10 Brush Tool modifiers

I |
| Options_

Brush M@}[je—'
Brush

o
Brush Ji@ne

Lock (&

Brush tool modifiers contain the Faucet modifier, the Eraser Shape modifier, and the
Eraser Mode modifier (Erase Normal, Erase Fills, Erase Lines, Erase Selected Fills and
Erase Inside).

3.4 Flash Tint Tweening and Animation

With tint tweening you can change the color of an object. Tweening creates frames
between keyframes. Keyframes are different cel created for each action and which
synchronize motion change from one stage to another. Tweening is an action which
requires calculating the number of frames between keyframes and then sketching onto
a cel the series of different actions. Tint changes the color values of each keyframe
and with Tint Tweening you can change the color of an object.

Computer animation can imitate the classical technique, with keyframe, tweening and
layers. e.g., Macromedia Director and Flash both support these concepts, letting the
computer automate the tweening process where possible. But computer animation
introduces new techniques, designed to conserve resources e..g, rather than reproduce
an entire cel for each frame, individual objects (called sprites in Director) move
across a background image. Authorware motions give this effect; Director
animations provide finer control of sprites. Morphing effect can be achieved by
dissolving from one image to another, e.g., from one face to another — many
specialized morphing software products available.

Example: In this example you will learn how to change the color of an object.
Step 1

Load Adobe Flash.

Choose Insert > New Symbol.

Note: To add Tint effects the object must be a symbol.

Step 2

87



CIT735 MODULE 3
Name the symbol "changecolor" and select the Graphic option in
Behavior. Click OK.

Note: You will now be taken to the symbol generator in the Flash program. Here
you create symbols. Symbols can be dragged to the stage of your movie after you have
created them.

Step 3

Choose the Text tool in the left toolbox. Choose Text > Size > 36 from the top menu
to make the text big. Choose Text > Style > Bold to make the text thick.

Step 4

Click in the work area and write "Color Changing Text".
Step 5

Jump back to the movie. Do this by choosing

3.5 Flash Shape Tweening

With Shape Tweening you can change one object into another. In this example you will
learn how to change one object into another.

Step 1

Choose the Text tool in the left toolbox. Choose Text > Size > 48 from the top menu
to make the text big. Choose Text > Style > Bold to make the text thick.

Step 2

Click in the work area and write "Hello".
Step 3

Right click on the text you just wrote and choose Panels > Align from the pop-up
menu.

Step 4

In the Align box select the "To Stage" button first. Then click on the "Align
Horizontal Center" button and the "Align Vertical Center” button. Close the Align
box.

Step 5

Select the Arrow Tool and click on the text. Choose Modify > Break
Apart from the top menu.

Step 6
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Insert keyframes at Frame 24, 50 and 51.

3.6 Flash Button 1

In this example you will learn how to insert an image, convert it to a button, and add a
URL to it so it becomes a link.

Step 1

Choose File > Import to import an image that will become a button. Locate the
image and click Open. The image will be saved in the Library.

Step 2
Select the image with the Arrow tool.
Step 3

Convert the image to a symbol. Choose Insert > Convert to Symbol from the top
menu. Name the symbol "button™, choose Button from the Behavior list and click OK.

Step 4

Right click on the image. Choose Actions from the pop-up menu.

Step 5

In the Object Actions box click on the + sign. Choose Basic Actions > Get URL.
Step 6

Enter a full URL in the URL field (like http://www.w3schools.com).

Step 7

Choose target in the Window field. Close the Object Actions box.

Step 8

Choose Control > Test Movie from the top menu

3.7 Flash Button 2

In this example you will learn how to create your own button and add a
URL to it so it becomes a link.

Step 1

Choose Insert > New Symbol from the top menu.
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Step 2

Name the symbol "button”, choose Button from the Behavior list and click OK. In
the Timeline area, you will now see the four states of a button: up, over, down, hit.

Step 3

Select the Rectangle tool, pick a light red Fill Color and draw a rectangle in the
work area.

Step 4

Select the Text tool, pick a dark Fill Color and write "Click Me" over the rectangle.
Step 5

Select the Arrow tool and place the text in the middle of the rectangle.

Step 6

Add a keyframe to the Over State in the Timeline. The Over State indicates what
should happen when you mouse over the button.

Step 7

Select the Rectangle, change the Fill color to a light green.

Step 8

Choose Edit > Edit Movie to go back to the movie.

Step 9

Choose Window > Library to locate the button. Drag the button into the work area.

Step 10

Right click on the image. Choose Actions from the pop-up menu.
Step 11
In the Object Actions box click on the + sign. Choose Basic Actions > Get URL.

There are 3 types of symbols:

o Movie Clip
o Button
o Graphic
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